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Preface

This tutorial is a practical overview of the entire VisiQuest system. It is not
intended to replace the manuals. Instead, it was designed to be the quickest
way to learn about the system.

This tutorial takes the user step by step through the different VisiQuest
subsystems. Its hands-on approach is similar to a laboratory guide. For best
results, the user should work through the material in a linear fashion, with-
out skipping any section or chapter. We carefully chose simple and practical
experiments to present the functionality and capability of the VisiQuest system.

Chapter 1 gives an overview of the VisiQuest system, explaining how it is
used in data processing, visualization, and software development. It introduces
the principal VisiQuest components. It also presents the organization of the
VisiQuest system toolboxes. Lastly, it introduces the internal data model and
the ways the user community can interact with the VisiQuest developers.

Chapter 2 presents the three types of user interfaces: command line, graphic,
and visual programming. The goal of this chapter is to introduce you to the
VisiQuest visual programming environment. It also describes how the informa-
tion is stored, processed, and visualized. Beginning with this chapter you will
start experimenting with the system.

Chapter 3 continues to present VisiQuest programming features to solve
practical problems of importing and exporting data, and how to interface with
other software packages. More advanced features are presented, such as VisiQuest
variables and control connections.

Chapter 4 makes extensive use of the VisiQuest data model to represent
True Color and Indexed Color images. The validity mask concept is presented.

Chapter 5 presents advanced visual programming features, such as proce-
dures, flow control, and data transport mechanisms.

Finally, Chapter 6 contains a brief introduction to the software development
tools. In this chapter you will create a toolbox and develop two illustrative data
processing operators.

Throughout the book, many interesting and practical problems are pre-
sented. Our intention is to use the VisiQuest system as a tool to assist you in
learning and thinking in the field of data processing and visualization. VisiQuest
does not solve problems by itself.

You should have at least some experience of the UNIX operating system, to
be able to navigate through the file system, copy, delete, move files, and use
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a text editor. We assume that you have some practice with window managers
and the X Window System so that you are comfortable with window operations
such as move, raise, lower, focus, refresh, destroy, and iconify. We also assume
that you know how to program a computer.

Several registered trademarks appear in this tutorial: UNIX is a trademark
of X/Open Company, Ltd.; X Window System is a trademark of X Consortium,
Inc.; xv is copyrighted by John Bradley; gnuplot is copyrighted by T. William
and C. Kelly; PostScript is a trademark of Adobe Systems, Incorporated.

Typographical conventions

In this tutorial the following conventions are used:

Convention Description

Note: This is a note

Tip: This is additional useful information
%command

This is a command and its result

result

VisiQuest Binary executable names

Width A parameter input

Display Image A glyph

my input A string that the user has to type in
Run A button

Menu, submenu The menu and submenu names




Description of the practical experiments is mixed within the text. Para-
graphs on which you have to make an action with the software are specified by
numbers as illustrated below.

1. Here is described an action you must take.

A general comment or an explanation may follow the action.

2. Here is another action.
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Chapter 1

Introduction

In modern problem solving there is a need to process large data sets, multidi-
mensional and time varying data. Applications that require modeling, simula-
tion, animation, and algorithms to extract information from the data demand
computer-intensive operations. Finally, problem solving often requires collabo-
ration among interdisciplinary teams.

The area of data processing has seen a significant increase in the level of
interest from many disciplines. Data processing is continuously expanded by
areas such as neural nets, wavelet theory, mathematical morphology, data com-
pression and recognition, and artificial intelligence. With the dramatic drop
in the cost of digital systems and the equally dramatic increase in the level of
performance, the use of data processing in other disciplines is feasible. Data pro-
cessing plays a crucial role in the areas of document processing, remote sensing,
medical imaging, scientific visualization, telecommunications, robotics, biology,
and environmental engineering, among others.

In data visualization, we take advantage of the advances in technology (com-
puters, data networks, user interfaces, data processing algorithms) and combine
them with the powerful human visual system to solve problems. A principal
goal in data visualization is to gain understanding and insight into the data
under observation. To facilitate this process, a fast prototyping environment
and data processing and visualization operators are needed.

What is VisiQuest?

VisiQuest is a software integration and development environment that empha-
sizes information processing and data exploration. The objective of the ongoing
work of VisiQuest development is to build a complete application development
environment that redefines the software engineering process to include all mem-
bers of the work group, from the application end user to the infrastructure pro-
grammer, in the productive creation of software. The VisiQuest environment
accomplishes this objective
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e by providing a broad set of program services (libraries) that can be used
as a source of reusable code for visual program development;

e by providing visual software development tools that can be used to quickly
prototype new software and maintain developed software;

e by being portable and extensible;

e by supporting different levels of user interaction, from non-technical end
user to expert programmer;

e and by motivating a broad community to collaborate utilizing both syn-
chronous and asynchronous exchanges of resources and knowledge.

The figure shown below illustrates the different levels of user interaction.
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For end user solutions to scientific problems, VisiQuest may be used as it
stands, providing a rich set of programs for information processing, data ex-
ploration, and data visualization. Multidimensional data manipulation opera-
tors include pointwise arithmetic, statistic calculations, data conversions, his-
tograms, data organization, and size operators. Image processing routines and
matrix manipulation are also provided. Interactive data visualization programs
include an image display and manipulation package, an animation program,
a 2D /3D plotting package, a colormap alteration tool, and an interactive im-
age/signal classification application. In addition, 3D visualization capabilities
are offered: a number of data processing routines for 3D visualization are pro-
vided, along with a software rendering application. The VisiQuest operators



are generalized, so that each can solve problems in a variety of specific areas
such as medical imaging, remote sensing, process control, signal processing, and
numerical analysis.

Visual programming environments provide iconic elements which can be in-
teractively manipulated according to some specific spatial grammar for program
construction. Data flow is a naturally visible approach in which an algorithm is
described as a directed graph where each node represents an operator or function
and each directed arc represents a path over which data flows. By connecting
the data paths between nodes, users can interactively draw out a solution in
an intuitive manner that matches their mental representation of the problem.
Thus, a visual environment for problem solving introduces a level of abstraction
which provides accessibility to the functionality represented by the underlying
operators, regardless of the developer’s programming experience; moreover, it
increases the productivity of both experienced and novice developers.

Programs from the VisiQuest system are represented as visual objects called
glyphs. The program which corresponds to the glyph is called an operator.
To create a visual program, the user selects the desired operator, places the
corresponding glyphs on the workspace, and connects the glyphs to indicate the
flow of data from operator to operator, forming a network within a workspace.

Visual hierarchy, iteration, flow control, and expression-based parameters
extend the data flow paradigm to make VisiQuest a powerful simulation and
prototyping system. Data and control-dependent program flow is provided by
control structure glyphs such as if/else, while, count, and trigger. Visual sub-
routines, or procedures, are available to support the development of hierarchical
data flow graphs. Variables may be set interactively by the user, or calculated
at run time via mathematical expressions tied to data values or control variables
within the visual network.

By combining a natural environment of visual constructs with the pro-
gramming features typically found in textual languages, VisiQuest provides
a powerful problem-solving and prototyping system. Visual hierarchy, itera-
tion, flow control, and expression-based parameters augment the traditional
data flow paradigm so that VisiQuest can be used effectively in a number of
domains, including process control, simulation, and system integration. When
combined with the data processing and data visualization programs available in
the VisiQuest system, VisiQuest is particularly well suited for scientific data
processing and visualization.

The flexibility of the visual network scheduler allows this single visual pro-
gramming environment to simultaneously address the needs of diverse domains.
Furthermore, the visual programming paradigm is enriched by the ability to
combine operators from different domains as desired in a single visual program,
allowing the visual programmer to solve more complex and diverse problems
than would otherwise be possible.
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For application developers, the VisiQuest system consists of programming
services and software development tools that support all aspects of developing
new engineering and scientific applications. Applications written to VisiQuest
can take advantage of the same capabilities offered by the VisiQuest data pro-
cessing and visualization routines, including the ability to transparently access
large data sets distributed across a network, operate on a variety of data and
file formats without conversion, and maintain a consistent presentation with a
standardized user interface. The software development environment provides
developers with a direct manipulation graphical user interface design tool, au-
tomatic code generation, standardized user interface and documentation, and
interactive configuration management. The VisiQuest software development
system can be used for software integration, where existing programs can be
brought together into a consistent, standardized, and cohesive environment.

VisiQuest provides a powerful working environment for the academic, en-
gineering, and scientific communities, addressing many of the issues associated
with quickly developing X Window-based applications, prototyping solutions to
complex problems, and utilizing the resources of a distributed network. The
layered approach of the VisiQuest infrastructure and the concept of program
services provide developers with the flexibility to create complex applications,
while at the same time hiding the intimidating details of operating systems and
X Window Systems.



Organization of the VisiQuest software

A common misperception is that “VisiQuest” is a single application. In con-
trast to previous versions, VisiQuest does include a front-end application named
“VisiQuest”, from which the VisiQuest visual programming environment, the
manual, and demos are accessible. However, the VisiQuest system incorporates
hundreds of programs and thousands of library calls. The VisiQuest system
is distributed as a number of packages. FEach package contains one or more
toolbozes. VisiQuest is a complete data exploration and software development
environment that reduces time in solving complex problems, allows free sharing
of ideas and information, and promotes portability.

Each program of the VisiQuest system is located in a toolbox. A toolbox is
a collection of programs and libraries that are managed as objects. A toolbox
object is an encapsulation of programs and libraries normally related to a specific
application. The toolbox object has a predefined directory structure in which
its software objects are located.

A software object is composed of source code, documentation, and user inter-
face. The different categories of software objects are: library objects, kroutine
object, xvroutine objects, pane objects, script objects, and workspace objects.
Except for workspace objects, software objects have one or more User Interface
Specification (UIS) files that serve to specify the Graphical User Interface (GUT)
and Command Line User Interface (CLUI) of the software object.

A toolbox contains programs and libraries which have a similar function or
common objective. Similarly, the various VisiQuest packages group toolboxes
according to purpose. The packages and toolboxes which make up the VisiQuest
system include:

e The Kernel package, which contains the bootstrap toolbox (installation
and make utilities, Foundation services).

e The VisiQuest Base package, which contains: the devel toolbox (software
development environment), the design toolbox (the VisiQuest application,
GUI & Visualization services), the imagine toolbox (the VisiQuest visual
programming environment), the dataserv toolbox (data services), and the
envision toolbox (scientific visualization programs).

e The Data Manipulation package, which contains: the datamanip toolbox
(data processing routines), the image toolbox (image processing routines),
and the retro toolbox (additional image processing routines).

e The Geometry package, which contains the geometry toolbox (3D visual-
ization programs).

e The Sampledata package, which contains the sampledata toolbox (multi-
dimensional data sets).

e The Migration package, which contains The migration and db_migrate
toolboxes (utilities to assist in migration from an older version to a new
version of VisiQuest).
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e The Linear Algebra package, which contains the matriz toolbox (linear
algebra and matrix computation routines).

e The Streaming package, which contains the strearmnops toolbox (streaming
data services and operators).

e The Plotting package, which contains: the XprismPro toolbox (3D Plot-
ting package using OpenGL).

e The Documentation package, which contains: the documentation toolbox
(PDF files for VisiQuest online manual).

VisiQuest Software System Packages

Kernel

Data Processing

Khoros Base

dataserv
imagine

Sampledata Linear Algebra Geometry

Documentation XprismPro Streaming

documentation stream ops




The VisiQuest system provides the craftsman tool for managing a toolbox.
It allows the user to create, delete, and copy toolbox objects as well as software
objects. The second tool that comes with this system is composer. composer is
the user interface to the software objects and invokes all the operations needed

to manage them.
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The third tool provided guise, is an interactive graphical user interface

design tool.

4 Guise - Graphical User Interface Specification Editor
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Polymorphic Data Model

The VisiQuest system has its own data structure designed to manipulate mul-
tidimensional data. This data structure facilitates the processing of 1D signals
like audio or speech, 2D signals such as images, and 3D data such as volume
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information. In addition to these three dimensions, VisiQuest has a time dimen-
sion to represent the data in time and an element dimension to represent more
than one attribute to each data point. This data structure within the VisiQuest
system is known as the Polymorphic Data Model.

The polymorphic model consists of data that exists in three-dimensional
space and one-dimensional time. You can picture the model most easily as
a time-series of volumes in space. This time-series of volumes is represented
by five different data segments. Each segment of data has a specific meaning
dictating how it should be interpreted.

MASK Data marks data MAP Data
validity

value data
may index
into a map

mask element
vector

value element
vector 7/
/

VALUEData ,/ /. .’

/

see D W N = O

/ 7/, 7

/ /44
element vector , 4 P s
/ Ve
(L N J
volume of
vector data
in space
volumes through time >
LOCATION Data TIME Data
location data places
vector each
_-= . ° . volume
z explicitly
in time

places each

vector from

single volume
explicitly

in space

An overview of the Polymorphic Data Model is shown above. The polymor-
phic model consists of five data segments, with each segment serving a specific
purpose: wvalue, location, time, mask, and map. All of these segments are op-
tional; a data object may contain any combination of them and still conform to
the polymorphic model.

VisiQuest community interaction

The VisiQuest system evolution has thrived on real-time user enhancement,
on-line training, and permanent feedback from its broad spectrum of users.



The user community can interact with the VisiQuest developers via email and
newsgroups:

e Send email to info-request@accusoft.comto subscribe to the VisiQuest
mailing list.

e The web URL for VisiQuest is http://www.accusoft.com.

e The kbugreport utility is used to report bugs and facilitate interaction
with the developers.



10

Introduction




Chapter 2

Getting Started

The best way to get started with VisiQuest is to use the software. You benefit
most from this tutorial if you have access to VisiQuest so you can apply each
step as it is in this guide. This chapter walks you through a general overview
of VisiQuest.

Installation guide reference

VisiQuest has a detailed guide on how to install the software system called the
VisiQuest Installation Guide. If you are not responsible for the system instal-
lation, you may still want to read the section “Setting Up Your Environment”
(section 2.5). The easiest way to set up the VisiQuest environment is by ex-
ecuting kconfigure as explained in that manual. VisiQuest is installed when
the binaries are accessible and the file .kri/KP2001/Toolboxes is present in your
home directory. The Toolboxes file dictates which toolboxes are available to
you. Note that not all toolboxes mentioned in this guide will be available to
you unless all the VisiQuest 2001 packages have been installed. All these issues
are described in the VisiQuest Installation Guide.

Interfaces to Major VisiQuest Toolbars

VisiQuest is an environment for data processing and visualization and software
development. The two principal tools of VisiQuest through which the user can
interact with the system are VisiQuest and craftsman.

VisiQuest is a visual programming environment from which over three hun-
dred data processing and visualization operators can be invoked. It can executed
from the command line as follows:

%VisiQuest

craftsman manages the maintenance and development of software within
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the system, specifically the management of all the system toolboxes. It can be
executed with the following command:

Y%craftman

Another VisiQuest tool, composer , deals with software objects individually. It

can be executed from craftsman or from the command line. For example, to run
composer on the ”testl” software object of the TESTS toolbox, the following
command would be issued:

%composer -tb tests -oname testl

(From VisiQuest it is also possible to invoke the craftsman and composer

software development tools.

The VisiQuest Toolbar

Both VisiQuest and craftsman are accessible from the VisiQuest application,
a new feature of VisiQuest. The VisiQuest application also offers access to the
online VisiQuest manual, as well as the standard VisiQuest demos. To execute
the VisiQuest application, type:

%VisiQuest
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Er*r:_l Cantata
% Craftsman

Demo

Manual

Selecting the button displays VisiQuest , and selecting the
button displays craftsman . A button provides access

to the standard VisiQuest demos.

VisiQuest Version

To check the version of VisiQuest you are executing when running the VisiQuest

application, select |Version Information | from the File menu of the VisiQuest
application.

VisiQuest Manuals

To access the online VisiQuest manuals, click on the button of the
VisiQuestapplication. Note that the DOCUMENTATION toolbox contains
the manual files and must be installed for this option to work.

Interfaces to VisiQuest Operators

VisiQuest operators can be executed through three different types of user inter-
faces:
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1. CLUI, the Command Line User Interface,
2. GUI, the Graphical User Interface, and

3. VisiQuest, the Visual Programming Environment.

2.1 Command Line User Interface

To understand the structure of VisiQuest and the relationship among the three
types of user interfaces, it is best to start with the Command Line User Interface
(CLUI). Follow the instructions below to familiarize yourself with VisiQuest.

VisiQuest version

To check the version of VisiQuest you are executing, issue the following com-
mand at the UNIX prompt line:

. -
%kversion

VisiQuest version 3 3.2.0.0 (Mar 31, 2002)

Note: If the kversion command is not found, there may be a problem with
your PATH environment variable.

Listing toolboxes

The VisiQuest software system is composed of several toolbozes. A toolbox is a
collection of programs and libraries managed as a single entity, called objects.
The organization of the system in toolboxes greatly improves the modularity of
the system and encourages contribution from the user community.

To list the toolboxes included in the standard system, type in the following
command:

%kecho —-echo toolboxes

AUDIO BOOTSTRAP DATASERV DESIGN IMAGINE DATAMANIP ENVISION
GEOMETRY IMAGE ..,

Note: If an error message is received, there may be a problem with the file
.kri/KP2001/Toolbozes in your directory.

Toolbox as a collection of objects

Typically, a toolbox contains programs and libraries which have a similar func-
tion or common objective. The toolbox DESIGN, for instance, contains libraries
that comprise GUI and visualization services, and the VisiQuestToolbar. To
list the objects contained in the toolbox DESIGN, type
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%kecho -tb design -echo objects

xvwidgets xvobjects VisiQuest xvutils xvforms khelp xvrun

If you know the object, you can also search for its toolbox. For instance, to
find which toolbox the object kadd is associated with, type

%kfindobj -oname kadd

Toolbox Object Path
DATAMANIP kadd  objects/pane/kadd

You have verified that the kadd object is in the DATAMANIP toolbox.

CLUI syntax

As you can see above, all the operators in the CLUI interface have a consistent
format. The program name is typed in, followed by as many arguments as
necessary. The arguments can appear in any order and they are identified by
an associated -variable tag.

Object usage

The options -U and -usage can be used with any command to describe its com-
mand line syntax. The —usage option gives the full list of arguments, including
standard VisiQuest arguments, while the -U option gives only the arguments
that are specific to that command. The option -U can be used with any com-
mand to describe its command line syntax:

%kversion -U

Usage for kversion: This script will print out the version
of VisiQuest

[-tb] (string) toolbox name
(default = none)
[-oname] (string) Program or Library Object Name
(default = none)
[-date] (flag) Display the date only
ignored if -tb and/or -oname specified
[-name] (flag) Display the name only

ignored if -tb and/or -oname specified
[-version] (flag) Display the numerical version only
ignored if -tb and/or -oname specified
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Object information

Once you know to which toolbox an object belongs, you can find relevant in-
formation associated with it by using kecho. To show the information of the
object kadd in the toolbox DATAMANIP, execute the following command:

%kecho -echo object-info -oname kadd -tb datamanip

begin DATAMANIP: :kadd

binary-name=

category=Arithmetic

subcategory=Two Operand Arithmetic
short-description=0utput = Inputl+(Input2 or Constant)
icon-name=Add

in-VisiQuest=YES

end DATAMANIP: :kadd

From this output, it is installed in VisiQuest under the icon name Add, and
found under the category Arithmetic, sub-category Two Operand Arithmetic.
The short description briefly explains the operation of the object.

Man pages

For a full description of an object, access its man pages. For instance, to know
more about the kecho command, execute

%kman kecho

The CLUT interface has many more properties and rules. The full description
is found in the Introduction, section E, of the VisiQuest End Users Guide. The
End User Guide, along with the other VisiQuest manuals, are available online
from the VisiQuest application. Start the VisiQuest application by typing

%VisiQuest

then click on the | Manual | button to access the online manuals.

Aliases

Aliases in VisiQuest provide a convenient shorthand for long pathnames to input
files without having to remember the location of files. It also makes programs in
VisiQuest (either visual programs or scripts) more portable across installations,
since the alias mechanism determines the exact location of the data files.
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Aliases are specified by words separated by colons. In the example below,
a data file stored in the DATASERV toolbox is copied to your directory under
the name gull.kdf by using the VisiQuest copy command kcp. The alias
image:gull corresponds to the path where the data file is actually located.

%kcp -i image:gull -o gull.kdf

Creating aliases

Each toolbox in VisiQuest can define its own aliases. The file where the aliases
definitions are stored is located in each toolbox (toolbox-path/repos/Aliases).
Each line defines an alias. Below is an excerpt of the line of the file
.../VisiQuestbase/dataserv/repos/Aliases where the image:gull is de-
clared.

image:gull $DATASERV/data/images/gull.kdf.gz

The aliases mechanism is available both in CLUI and GUI interfaces. You
can learn more about the aliases syntax and capabilities in the Introduction,
section G.3 of the VisiQuest Users’ Guide.

2.2 Graphical User Interface

While the Command Line User Interface (CLUI) is sufficient to execute any
VisiQuest program, a Graphical User Interface is also available for every pro-
gram. There is an exact correspondence between the CLUI and GUI interfaces.
An advantage of using GUI interfaces is that you do not need to remember all
the options that each object provides. Another advantage is that you can access
it from the VisiQuest visual programming environment.

To better illustrate the equivalence between the CLUI and GUI interfaces,
you will work with the kfindobj object. From its usage output shown below,
you can see that kfindobj has three optional parameters: -tb, -oname, and

-type.
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%kfindobj -U

Usage for kfindobj: search for software objects in toolboxes

% kfindobj
[-tb] (string) Toolbox to search
(default = nomne)
[-oname] (string) Software object name
(default = none)
[-typel (string) Software object type
(default = nomne)

To invoke the GUI of an object, execute the object with the -gui option.

%kfindobj -gui

This displays the pane of the operator kfindobj, with its associated param-
eters. The pane is the GUI representation of an object.

4 |seart=h for software objects in tooboxe

search for software objects in toolboxes

Dptiuns Run Help | | Close

G

g
~

e

There are three parameters in the kfindobj pane: Toolbox Name, Object
Name and Object Type. Each is related to one of the three optional parameters
in the CLUI interface. When a parameter is optional, there is a button on
its left to activate or deactivate it. In the case of kfindobj alone, the three
parameters are deactivated.

Activate the Object Name parameter and type in kadd. To type in a param-
eter, the pane window must be in focus and the mouse pointer must be inside
the box when the parameter is entered.
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4 |seart:h for software objects in tooboxes

search for software ohjects in toolboxes

Options Run Help | | Close

[v' Object Name |kadd

To execute the object, click on the button in the pane and observe
its output in the UNIX prompt line. The CLUI equivalent command is shown
followed by the output of the command execution. Note the GUI and CLUI
equivalence. The Object Name parameter is associated with the option -oname
in the CLUI interface.

$DEVELBIN/kfindobj —oname "kadd"
J

Toolbox Object Path
DATAMANIP kadd  objects/pane/kadd

On-line help

There is an on-line help available in every GUI interface. To invoke the on-line
help, click on the button of the pane object.
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4 Online Help

? Online Help Other Fles =

1. PROGRAM MAME

kfindobj - search for software ohjects in toolboxes

2. DESCRIPTION

kfindobj prints out alist of software objects, where the list of
objects i5 determined using find(1) like options. “ou can search
all toolboxes for a specific object, list all software objects of a
given type, or list all objects within one toolbox. These options
can be combined to further restrict the search.

3. PAME ARGUMEMNTS

$DEVELfbjects/kroutineskfindobjhelpsefindobj.hlp

Close

Close the on-line help window and the kfindobj pane by clicking on their

buttons.

Directory Browser

VisiQuest provides the Browser tool as an alternative to typing in the filename
specification. Any input or output file parameter in a GUI pane has a button
to invoke the browser tool.

To experiment with this tool, use the khelp command, which displays on-line
help or ASCII files.

1. Type in

%khelp -gui
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- |Di5|:|lal',|r a Text File or Directory of Text File:

Digplay a Text File or Directory of Text Files

| Input File (Dir) I |

This command requires an ASCII file as input. You can type the filename
directly into the Input File parameter field or you can invoke the browser
tool.

2. Invoke the browser tool by clicking on the | Input File (Dir) ‘ button.

This displays the Directory Browser tool listing all the files and subdirec-
tories found in the current directory. By double-clicking on a directory
name, or by typing the appropriate path in the Directory/Filename box
you can traverse directory structures and select filenames.

The browser tool also works with the alias functionality.

3. Click on the browser button or on the folder icon to toggle

between the Directory Browser and the Aliases Browser.

4. Select kernel: by clicking on it, followed by a click on the button,
or by double-clicking on it. Then scroll down the list, select sobel_y, and

click on the button.
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< Khoros Browser Ltﬂ < Khoros Browser Ltﬂ
i/ o]

archives E“ geometry: E“
audios Qifs:

hins

hincoms |:|

hinmachy kernel:

hootstrap/ lgd:

compiles masks:

cplustestss plotZd:

datal EH plot3d: E'J
Current Directary / Filename Current Alias

famdfjeevesfexportivision/mirages | F Iimage: | F

Ok Cancel Help Ok Cancel Help

The Aliases Browser closes and the selected filename appears in the file-
name parameter field.

< Display a Text File or Directory of Text Files |_|_|_|

Display a Text File or Directory of Text Files
o

| Input File (Dir) Ikemel:sohel_y |

5. Click on the button to execute the khelp command to view the
ASCII file kernel:sobel_y in the on-line text viewer.
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- |Viewirg “iresearchivision'oasis/dataservidata’kernels/sobel_y.asc

-1 01
-2 02
-1 01

FOATASERY/dataskernels/sohel_y.asc

Close

6. Close the text viewer and close the khelp pane.

Before introducing VisiQuest, the third and most widely used VisiQuest
interface, it is important to understand the VisiQuest data model because most
operators process the data stored in this model. The data model is used for
storing, processing, and visualizing information. We will discuss the data model
using the CLUI and GUI interfaces. Later, the same example will be carried
out with VisiQuest to see the advantages of visual programming.

2.3 Data Model

A good understanding of the internal data structures used in a software en-
vironment is necessary to process and display data. The VisiQuest system
was designed to manipulate multidimensional data, using a Polymorphic Data
Model.

The polymorphic model consists of five data segments: value, location, time,
mask, and map.

To set the groundwork for the discussion of VisiQuest, this section will
explore the value segment of the Polymorphic Data Model. The full discussion
of this important concept is in Chapter 4.

The value segment: signals, images, and animations

The value segment can store data in five dimensions: width, height, depth, time,
and element.
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Data file header information

In data processing, it is critical to understand the nature of the data file being
processed. Basic information concerning the size, the data type, the dimension-
ality of the data, data segments associated with the data, and file format must
be known before processing the data.

The routine kfileinfo allows you to find the data information stored with
the data on a disk file. Accessing kfileinfo gives you file header information.
Using the example of the data file gull.kdf, which is aliased to image:gull,
execute

%kfileinfo -i image:gull

# Name: image:gull

# Comment: # End Comment # Machine Architecture: Big Endian
IEEE

Date Created: Tue Aug 09 17:15:37 1994

Storage Format: kdf

Format Description: VisiQuest 2.0 Data Format (kdf)
Sub-0Object Position: 0 , 0 , 0, 0 , O

World Coordinate Point Size: 1 , 1,1, 1, 1

Color Space Model: O (invalid)
Has Alpha Channel: O

maskedValuePresentation: O
-- Value Data —--

Data Type: Unsigned Byte
Size: Width=256, Height=256, Depth=1, Time=1, Elements=1

H OH HF H H HHHHHHHHEHRH

Interpreting kfileinfo

i From the output produced by the operator kfileinfo, you obtain several
pieces of information stored as attributes: the full path location of the data file
in the system, the machine that created the file and its internal data storage
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type, date of creation, the file format, data segments associated with the data,
and its dimensions. The VisiQuest data model supports 5 dimensions in the
“Value Data” segment: width, height, depth, time, and elements.

The gull data file stores a two-dimensional (2D) signal or image with a width
of 256 points, known as pizels (abbreviation for picture elements), and a height
also of 256 pixels. The total number of points is then 65,536 (256 x 256) of data
type Unsigned Byte, as reported in the output under the “Value Data” attribute
depicted below.

# —-- Value Data —-
# Data Type: Unsigned Byte
# Size: Width=256, Height=256, Depth=1, Time=1, Elements=1

Digital image

A digital image is a two-dimensional matrix of pixels. The process of displaying
an image creates a graphical representation of this matrix where the pixel values
are assigned a particular grey-level (monochromatic image) or a particular color.

You may display this image on your screen by using the putimage operator.

%putimage -i image:gull
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Coordinates

Above is a graphical representation of the image produced by the putimage
operator available in VisiQuest. Pixels with low values are assigned dark grey-
levels, and high pixel values are assigned bright grey-levels. When you point
the cursor at a particular pixel, the small position window below the image
gives the actual pixel value and its coordinates. The top-left pixel is located at
coordinate (0,0). The lower right-hand corner pixel has coordinates (255,255).

You can exit putimage by (1) selecting Quit from the File menu, by (2)
double-clicking on the displayed image, or by (3) typing the <q> key when the
displayed image is in focus.

Editimage

Another visualization operator, editimage, gives you full interactivity to ex-
plore and gain insight from the data. The steps below show how to use editimage
and how to better understand the digital image representation by zooming to a
small portion of the image, by displaying the pixel values, and by changing the
color assigned to them.

Invoke editimage from the command line, without listing parameters.
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%editimage

Now follow these steps:

1. Select Open... from the Files menu to access the Input Files pane.

2. Access the browser tool to read and display the image:gull data file.

Click on the button. When the browser pane is displayed,

click on the button or folder icon. Use the scroll bar to find

the image aliases directory and double-click on it. Use the scroll bar
again to locate the data file gull and double-click on it. At this point the

browser pane disappears. Note that in the | Input Image | box the string

image:gull is displayed. Alternatively, you could type in image:gull
directly in the Input Image parameter.

3. Close the Input Files pane by clicking on the button.

4. Select Zoom... from the View menu and place the zoom window on your
screen. Note that as you move the mouse over the image displayed by
editimage, a small portion of the image around the mouse is displayed in
the zoom image window, revealing the discrete nature of the digital image.

5. Select Pizel Values... from the View menu to display the Pixel Values
window. Similarly to the zoom window, this shows a zoom of the image
but with the actual pixel values.

6. Select from the menu to access the

subform. Use the scroll bar in the Autocolor Procedures table to access
the colormap SA Pseudo. This changes the previous grey-scale colormap
used to display the image to a new colormap, which is called a pseudo
colormap. You can use a pseudo colormap to enhance finer details of the
image that cannot be seen in the grey-scale colormap.

7. Use the mouse to navigate the editimage window and note that the pixel
values have not changed by applying the pseudo colortable. The pseudo
colortable affects only the color representation assigned to the pixel values.

8. Open the Input Files again and change the Input Image parameter to
image:head and press the <Enter> key. The new image is displayed in
the editimage windows. Verify that in this image, the pixel values are not
restricted to the interval 0-255 as many other visualization systems are.
You can change the Input Image to image:ankle MRI image and verify
that the pixel values in this image are complex.

Note: It may take a while for the pixel values be updated.
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9. Exit editimage by selecting Quit from the File menu. You will be
prompted for a confirmation.

You can find detailed information regarding the functionality of editimage
in Chapter 4 of the Envision Toolbox Manual, which is part of the VisiQuest
Users’ Guide.

4+ EDMMAGE 4 Editimage: Golormap Llﬂ
File View  Select  Options
Autocolor Procedures Colormap Operations
HLS Spiral = Elue Filter =
HSY Rings Chain Left
! o RGE Cube Chain Right
- 2 RGE Distance Green Filter
4 RGE Spiral Invert Qriginal
RGE Triangle Invert
Raintiow Red Filter
Randam Reverse
& Rotate Blue Left
Standard Dew Entata Bliue Rinht
4 Editimage: Zoom Lﬂ (RO

4 Editimage: Pixel Values |l
Pixel ¥alues
=

width [7 # Show Color? ¥

Height {9 ’

5 Update mode Button Press F 2

Zoom Factor: Ia |f -

Update mode:

Button Press

Location Marker Type:

Visualizing an image sequence

The animate operator is an interactive image sequence display tool. This tool
visualizes 3D or higher dimensional data by sequencing 2D frames. You can
use it to visualize volume data where the depth dimension of the value segment
is used, or to visualize a data set where the different frames are stored in the
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elements or time dimensions. Execute the kfileinfo to display the header
information associated with the file sequence:bushes.

%kfileinfo -i sequence:bushes

# Name: /home/VisiQuest/Datamanip/data/sequences/bushes.kdf
# Comment:

This is an image sequence provided by Sandia National Labs,
taken by G.Donohoe and E.Hoover in the Sandia Labs playground.
End Comment

Machine Architecture: Big Endian IEEE

Date Created: Sat Aug 27 19:22:30 MDT 1994

Storage Format: kdf

Sub-0bject Position: 0 , 0 , 0 , 0, O

World Coordinate Point Size: 1 , 1 , 1 , 1, 1

Color Space Model: O (invalid)
Has Alpha Channel: O

-- Value Data --
Data Type: Unsigned Byte (4)
Size: Width=256, Height=256, Depth=1, Time=20, Elements=1

H OH HF O H HEHHHHHEHHER

. From the kfileinfo, you can observe that this data is stored as a sequence
of 20 images in the time dimension of size 256 x 256 pixels. To move through
the data, execute the animate operator by typing

%animate -i sequence:bushes
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File Select Options Help

S Y o 2

Animation Frame Mumber: 0
[ 8= 35= Z23)

You can move through the frames forward or backward one frame at a time
or automatically through all of them by using the five buttons above the image.
Selecting Attributes from the Options menu, you can control the speed of the
sequencing, changing the attribute Animation Speed.

Exit animate by selecting Quit from the File menu.

Generating 1D data

You used putimage and editimage to visualize 2D images and animate to
visualize image sequences. You will now use the plotting facilities in VisiQuest
to visualize 1D data.

First generate a sinusoidal signal of size 50 samples by using the kgsin
operator.

1. Execute the following:

%kgsin -gui
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-+ Generale Object Containing Sinusoidal Value Data Ll.|.|

Generate Object Cantaining Sinusaidal Yalue Data

Width 512 ’
Height |512 ,
Depth 1 ’
Time 1 f
Elements I] ‘,
[V sinfw+hedstsg) [ sinfujesinghy+in{d)+sin(t)+sin(e)
v amplitude [«

K

L

u

[
Mumber of sine waves Phase Offset (degrees)
MNum. along Width 1.0 Width Phase Off 0.0
Mum. along Height 1.0 Height Phase Of. | 0.0
Mum. along Depth 1.0 Depth Phase O |0.0

Mum. along Time 1.0 Time Phase Off. 0.0
Mum. along Elements |1.0 Elements Phase Off (0.0

Select Data Type ‘ﬂual |

Output | ~varftmp/fio5446.0 |

2. In the pane of the kgsin command, set the Width parameter to 50 and
the Height to 1.

This will generate a single sinusoidal wave with 50 floating point samples
in the width dimension with an amplitude of 1.0.
3. Type in the filename sine50w.kdf in the Output parameter.

The kdf extension is a convention used for the VisiQuest Data Format
(KDF) files.

4. Click on the button to execute the command and then on
to close the pane.

Verify that the generated file was created with the proper size by using
kfileinfo. The width dimension should be 50 and all other dimensions
should be 1. Verify that the data type is Float.



32 Getting Started

5. Execute

%kfileinfo -i sinebOw.kdf

Name: ../experiments/sinebOw.kdf
Storage Format: kdf

Data Type: Float

#

#

#

# -- Value Data —-

#

# Size: Width=b50, Height=1, Depth=1, Time=1, Elements=1

Putplot2

Use the putplot2 operator to plot the sinusoidal data.

6. Execute

%putplot2 -i sinebOw.kdf

7. Select Plot Options... from the Options menu to access the parameters of
this visualization operator.

8. Change the Plot Type pulldown menu to Line Marker to reveal the dis-
crete nature of the data.
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9. Change the Color Origination pulldown menu to Use Data Values. This
assigns a different color to different sample values.

10. Exit putplot?2 by selecting Quit from the Options menu.

In this section you learned how data is stored in a file. With the introduc-
tory knowledge of VisiQuest’ CLUI and GUI interfaces, you are ready to use
VisiQuest and to understand its connection with GUI and CLUI interfaces. In
the next section, you will repeat most of the experiments used in this chapter,
only using the VisiQuest interface.

2.4 VisiQuest

The third and most important user interface in VisiQuest is the visual program-
ming environment called VisiQuest. For many VisiQuest users, VisiQuest is
considered the showcase of the system, since you can access virtually all the
resources of the system. Everything you have learned so far is accessible via
VisiQuest, so indirectly you have studied the VisiQuest components.

Visual language programming

VisiQuest is a graphically expressed, data flow visual language. In VisiQuest,
a program is described as a direct graph, where the operators are represented by
the nodes and the data are represented by the arcs. A visual language provides
a visual programming environment for quick prototyping, testing, and creation
of new operators.

VisiQuest versus CLUI/GUI

We will reexamine the sinusoidal generation and plotting example using VisiQuest.
To illustrate how VisiQuest increases the productivity of scientists, engineers,
and application developers. By providing a natural environment which resem-
bles the block diagrams that are already familiar to practitioners in the field,
the visual language supports both novice and experienced programmers.

Invoking VisiQuest

1. There are two ways to execute VisiQuest. The first is to use the VisiQuest
application. Display the VisiQuest application by executing

%VisiQuest &

Now, bring up VisiQuest by selecting | VisiQuest | from the VisiQuest

interface.
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The second way to display VisiQuest is to execute VisiQuest it directly
from the command line by typing

%VisiQuest &

The “&” symbol at the end of the UNIX command line puts VisiQuest
in the background execution mode. In this mode, the command line is
not locked and you can invoke other commands. It is convenient to run
VisiQuest in background mode since it will run while you are performing
other tasks.

Once VisiQuest is running, the window of a visual programming workspace,
made up of a viewport containing a canvas, is displayed.

File Edit Workspace Options Control Glyphs  Objects Help

Areal MainWorkspace \
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VisiQuest menus and Command Bar

VisiQuest has seven pulldown menus through which the user can access
a variety of programs and utilities. The menus are File, Edit, Workspace,
Options, Control, Glyphs, Objects, and Help.

In addition, there is a workspace command bar which contains icons rep-
resenting the most commonly used commands from the VisiQuest in-
ventory. The icons are displayed just below the main VisiQuest menu
bar.

Note: The set of icons is variable: you can choose to display only those

you wish or you can make all of them disappear using the Preferences
subform of the Options menu.

File Edit Workspace Options Control Glyphs Objects Help

e o xXEERRN e |

Locating glyphs with Finder

Each operator in VisiQuest has a graphical representation called a glyph.
All CLUI objects that can be accessed via VisiQuest have a glyph asso-
ciated with them. A visual program consists of a number of glyphs placed
in a workspace and connected together, forming a network.

The glyphs can be brought into the visual programming workspace via
the Glyphs menu or the Finder tool. First, we will use the Finder tool to
access the glyphs, followed by a discussion of the Glyphs menu.

2. Open the Finder tool by clicking on the pulldown menu with the
left mouse button and drag it to the very end where it reads Find.... Place
the Finder pane on your screen and in the Finder Expression parameter
box, type in a keyword that may be related to the operator you wish to
locate.
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4]

kgamma - Log Gamma - Compute Log Gamma Function (Fundamental Image Proces

kmaximum - kaximum - Returns Higher Value between Input 1 and {Input 2 or Cong
kminimurm - Minimum - Returns Lower Value between Input 1 and (Input 2 or Consts
kmod - kodulus - Cutput = Remainder of Input 1 ¢ (Input & or Constant)] (Fundame
kmul - Multiply - Output = Input 1 * {Input 2 or Constant) (Fundarmental Image Proc
kpow - Power - Cutput = (Input 11 ** {Input 2 or Constant) (Fundamental Image Pro
ksub - Subtract - Cutput = Input 1 - {Input 2 or Constant) (Fundamental Image Pro
ksubfrom - Subtract From - Output = {Input 2 or Constant) - Input 1 (Fundamental |
kldexp - lde=p - Output = Input 1 7 2**(Input 2 or Constant) (Fundamental Image P
kahs - Absalute Value - Output = Absolute Value of Input (Fundamental Image Pro
kceiling - Ceiling - Cutput = Integer Ceiling of Input (Fundamental Image Processin

kcmpl<Zreal - Complex to F-:eall— Output = Real, Imaginary, Phase, or Maunitudeﬁﬂ

Finder Expressionl

7

Help

Finding kgsin

<Enter> key.

Find the operator kgsin by typing the keyword sinusoid followed by the

This produces an output which corresponds to the routines that deal with
sinusoids. Note that by moving the scrollbar at the bottom of the window
to the right, the Category, Subcategory, and Name of the kgsin operator
appear in parentheses ” (Input/Output: Generate Data: Sinusoid)”. These
can be used to find the kgsin operator in the Glyph menus.

the left mouse button and then clicking on the
double-clicking on its line description with the

Select the desired routine either by (1) clicking on its line description with

Open | button, or (2) by
eft mouse button. Move

the cursor to the VisiQuest workspace and place the glyph on it.

5. Close the Finder pane.
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10.

11.

12.

Locating glyphs with the Glyph Menus

Glyphs can also be created using the Glyph Menus. Here, we know the
category, subcategory, and name of the glyph we are looking for.

. Select Input/Output from the | Glyphs | menu.

Holding the button down, move the mouse to the right of Input/Output
and select Generate Data .

. Holding the button down, move the mouse to the right of Generate Data

and select Sinusoid.

. Finally releasing the mouse, move the cursor into the VisiQuest workspace

and place the glyph on it.

Moving the Sinusoid glyph

The Sinusoid glyph is the VisiQuest interface to the object kgsin. You
can move the glyph around the workspace by clicking on it with the left
mouse button, and while keeping the mouse button down, drag the glyph
to the desired location. Releasing the mouse button leaves the glyph in
the new position.

Glyph pane access

Open the pane associated with the glyph by clicking on its upper left-hand
corner. Observe the change of the direction of the pane access icon in the
glyph. Its state indicates if the pane is open or closed.

Notice that the pane you opened is exactly the GUI interface of the kgsin
operator used before.

In the same manner as before, modify the number of samples along the
Width dimension to 50 and along the Height dimension to 1.

Close the pane by clicking on the button or by clicking again on
the left-hand corner of the glyph.
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Options

a1z

a2

How a glyph executes

13. Execute the operator by clicking on the middle square of the glyph. You
will notice that it changes to red when it is executing.

When the glyph is executing, its equivalent CLUI command is displayed
in the console area of VisiQuest (its lower window).
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14.

15.

16.

# (new) DATAMAMNIP kgsin Sinusoid
FDATAMANIPBIMAgsin -wsize 90 -hsize 1 -dsize 1 -tsize 1 -esize 1 —wnum 1 -wp O -hhum 1 -hp O -dhum 1 —-dp © -trhum 1 -tp O

1 ||

After execution, the glyph changes back to grey and the small colored box
on the right of the glyph changes from yellow to green.

This small colored box is called an output port. It represents the output
file parameter of the Sinusoid glyph. The color of the port indicates the
availability of the data associated with it. After execution, it turns to
green to indicate that the output file is available.

Connecting two glyphs

Locate the putplot2 operator by using the Finder tool. Follow the same
steps used to locate the Sinusoid glyph. The VisiQuest interface to the
putplot2 operator is the Display 2D Plot glyph. Place the glyph to the
right of the Sinusoid glyph.

Open the pane of the Display 2D Plot glyph and place it to the right
of its glyph. Observe that the parameter Input File needs to be filled out
with the name of the file generated by the Sinusoid glyph. This will be
done automatically when you connect the glyphs.

Display &=is (200

Connect the output of the Sinusoid glyph to the input of the Display 2D
Plot glyph by clicking on the output box of the Sinusoid glyph, followed
by another click on the yellow input box of the Display 2D Plot glyph.

As soon as you do this, the filename automatically appears in the Input
File box of the 2D Plot pane. Note that the color of the connection is
green, indicating that data is available. The name of the file is generated
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17.

18.

19.

randomly and it is stored in the temporary directory indicated by the
environment variable TMPDIR.

- Mvarftmpfiol A76.1
Display &xs (20) i

Running 2D Plot inside VisiQuest

Close the pane of the Display 2D Plot operator and execute its glyph by
clicking on the center box. The result of the execution is the plot window
of the sinusoidal signal generated by the Sinusoidal glyph, exactly as
before when you were using the CLUI and GUT interface.

You can stop the Display 2D Plot glyph either by clicking on the red

center box of the glyph or by clicking on the button of the plot
window.

Data Object Info

Locate kfileinfo by using the Finder tool. The VisiQuest interface
to this operator is the Data Object Info glyph. Place the glyph below
the Display 2D Plot glyph and connect its input to the output of the
Sinusoid glyph by clicking on their input/output colored boxes.
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20.

21.

22.

23.

Note: The style of the glyph connections can be changed to spline as in
the figure above by accessing the Preferences form located in the VisiQuest
Options pulldown menu. Click on the | Glyphs | button preferences and se-
lect spline in the Set Connection Type To field.

Optional input/output parameter

Open the pane of the Data Object Info glyph and note that it has two
parameters, one Input and one Qutput, which correspond to the input and
output connections in the glyph. Observe that the Output parameter has
a grey box associated with it. This indicates an optional parameter. If this
output parameter is enabled, the ASCII file generated by this operator is
written to it. If it is disabled, the file is sent to the standard UNIX output
stdout.

If the Output parameter is enabled, disable it by clicking on the associated
grey box and close the pane by clicking on the button. Observe
that the output box connection changed its color to blue, indicating that
the output is optional and it is not enabled.

4 Print File Information

Print File Information

| Input I

Information/error dialog boxes

Execute the Data Object Info glyph.

The result of this operator is sent to the standard output, indicated by the
Console Buiton. The console button appears at the bottom of the glyph.
When it is lit up in green, this indicates that the operator associated with
the glyph has sent a message to the standard output (stdout).

Click on the Console Button to see the message.
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4 Glyph Help Oulput |l

Output For ‘Data Object Info’

# Name: Avar/tmp/ioZ251A,0

# Comment:

# End Comment.

# Machine Architecture: Big Endian IEEE

# Date Created: Tue Jun 15 11:59:56 1939

# Storage Formaty kdf

# Format Description: Khoros 2,0 Data Format tkdf:

# Sub-Object Positiony O, 0,0, 0,0

# World Coordinate Point Size; 1 .1 .1 .1 .1

#

# Color Space Model: O {irwalid

# Has Alpha Channel:

#

# maskedYaluePresentation: 0O

#

# —— Yalue Data —

# Data Type: Float

# Size: MWidth = 512, Height = 512, Tiepth = 1, Time = 1, Elements = 1

Mo File Currently Being Displayed
S

If the console button lights up in red, it means that the glyph has sent an
error message to the standard error (stderr). In this case, you would click
on the same Console Button to see the error.

24. Close the text window.

Saving a workspace as a file
Congratulations, you have just created your first VisiQuest visual pro-
gram that consists of a network of three glyphs.

25. Save this program into a file, by accessing the Save File option located on
the File menu. A short-cut is available by typing <Ctrl-S>. Enter the
filename sine.wk for the workspace file to be saved on disk, and click on
the button. Typically, workspace filenames are given the extension
“wk,” but you are not restricted from creating your own convention.
Clearing and restoring a workspace

26. Clear the workspace by accessing this option in the Workspace menu.
Click on the button to reconfirm your wish to clear the workspace
area.

27. Now, to verify that you have saved the sine.wk workspace correctly, re-

store it by accessing the Open File option found in the File menu (short-
cut <Ctrl-0>. This brings up the File Browser tool through which you
locate the file sine.wk and load it back into the VisiQuest environment.
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VisiQuest as an event-driven scheduler

Once the workspace is restored, run the entire visual program by accessing
the Run option in the Workspace menu. Notice that each glyph is executed
as soon as its input data is available. VisiQuest interprets the visual pro-
gram and schedules glyphs, dispatching them as processes. It is for this reason
that the program execution in VisiQuest is data-driven. Next, you will see
that VisiQuest is actually an event-driven scheduler. It responds to parameter
changes and supports mechanisms for glyph synchronization.

VisiQuest execution

VisiQuest can be in one of two modes of execution: stop or run. There are
two buttons in the command bar which are short-cuts for the Run and Stop
options in the Workspace menu. Together they display the two modes by
which VisiQuest can schedule glyphs: stop and run. When you execute a
workspace either by selecting the Run option or by clicking on the icon
button, VisiQuest enters in the run mode. When you stop the execution of the
workspace by selecting the Stop option or by clicking on the icon button,

VisiQuest enters the stop mode.

Stop mode This is the default VisiQuest execution mode. In this mode you
can execute each glyph individually by clicking on the glyph middle square
button. In the stop mode, and any changes to a glyph’s parameters will
not rerun the workspace. For the changes to take effect the workspace
must be rerun. This status is shown in the | Run | and | Stop | icon buttons

in the command bar.

Run mode In the run mode, VisiQuest executes all the glyphs in the network
following a data-driven and an event-driven scheduler until they reach
a stable condition. In this mode, VisiQuest is ready to schedule any
glyph that receives an event. There are many events, such as individual
execution of a glyph, a change on its input data or control connection or
a change on a live pane parameter. The status of the run mode is shown
below. Observe the bitmap color differences between the stop and run
modes. The color difference is very subtle.

2%
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In either mode, while there are glyphs running, the icon button

shows this by changing to
%

Experimenting with VisiQuest run modes

To better understand the VisiQuest execution modes, use the sine.wk workspace.

1. Put the workspace in stop mode by clicking on the button in the
VisiQuest command bar menu. This allows you to execute each glyph
manually. Try running the Sinusoid glyph. Observe that the network
enters in run mode and back to stop mode.

2. Execute the workspace, by clicking on the workspace icon of the
command bar. This schedules the Display 2D Plot and the Data Object
Info glyphs. Note that the workspace enters in the run mode. After the
network reaches a stable condition, it stays ready to schedule any glyph if
a new event occurs.

3. Manually execute the Sinusoid glyph to see that the workspace is re-
executing again.

4. Now, open the pane of the Sinusoid glyph. Notice that there are pa-
rameters which are live, as shown by the lighting bolt to the right of the
parameter input. An example of a live parameter is Width.

‘Width =0 f

5. Change this parameter to 100 and, as soon as you press the <Enter> key,
the Sinusoid glyph is rescheduled and the other glyphs which depend on
its output are also rescheduled.

If you change a non-live parameter, like the parameter Amplitude, the
glyph is not scheduled when you press the <Enter> key, but it is triggered
when you close its pane.

6. Change the Amplitude to 10 and close the pane to verify this condition.
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Resetting a workspace

Another command related to the workspace execution mode is Reset, available
both in the Workspace menu and in the command bar. Resetting a workspace
has the effect of making all the data connections invalid, changing their color to
yellow. If the workspace is in stop mode, this is the only effect. If the workspace
is in ready mode, the workspace is rescheduled.

Tip: Reset is useful when you want to rerun all the glyphs in a workspace after
changing parameters in many glyph panes.

VisiQuest as a prototyping environment

The basic features of creating and executing a visual program in VisiQuest
have been introduced. As a user interface, VisiQuest, compared to the CLUI
and GUI interfaces in VisiQuest, has numerous advantages. VisiQuest makes
it easier to find operators/glyphs. Input and output parameters are created
automatically from the network connections. Glyphs are executed harmonically
in an event-driven approach. And a workspace can be stored in a file for later
recovery.

Advanced VisiQuest Programming (Chapter 5) will conclude this discus-
sion by introducing the concept of glyph synchronization, flow control, and
procedures.

Conclusion

In this chapter, you have been introduced to the interfaces to VisiQuest tools.
You have learned how VisiQuest is related to the CLUI and GUI interfaces.
You have also built the first VisiQuest workspace program. In addition, you
were introduced to the VisiQuest data model, using 1D, 2D, and 3D data sets.

In the next chapter, you will explore additional features of VisiQuest as
you learn how to get data in and out of the VisiQuest environment.



46

Getting Started




Chapter 3

Import and Export Data

VisiQuest accepts most standard data file formats. Its operators can read all
supported formats without the need for an explicit conversion. When reading
a file, VisiQuest determines its file format and converts it to the Polymorphic
Data Model.

Operators by default write the data in the VisiQuest KDF file format. To
change the default mechanism, use the environment variable KDMS_FORMAT
with the name of the desired file format chosen from the supported formats.

3.1 Importing ASCII Data

The simplest supported format in VisiQuest is ASCII, which can represent 2D
(width x height) data. You will practice with this format first since it gives
you another intuitive way to understand the nature of digital images and digital
data in general.

By using a regular text editor, like xedit, you first create the file
myimage.ascii, consisting of a small two-dimensional matrix or image. After
the matrix is created, use the interactive image operator editimage to visualize
the ASCII file.

Creating a 2D file using xedit

1. Invoke the xedit text editor by typing

%xedit myimage.ascii
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2. Enter the following pattern:

1 2 3 4 5 6 7 8 9 10
11 12 13 14 15 16 17 18 19 20
21 22 23 24 25 26 27 28 29 30
31 32 33 34 35 36 37 38 39 40
41 42 43 44 45 46 47 48 49 50

3. Now save it and quit xedit.

4. In VisiQuest, clear the previous workspace.

Tip: VisiQuest can work with many workspaces simultaneously. To
understand how this works, select the New option under the File menu in
VisiQuest (or type <Ctrl-N>). This creates a new workspace area with-
out deleting the previous one. Observe that you can delete a workspace
area by selecting the Close... option, or type <Ctrl-W>.

Glyphs menu

In the new visual program you will need an operator to read the data file
myimage.ascii. In the last chapter you used the Finder tool to locate
glyphs. Another way to find an operator is through the Glyphs menu. All
the operator glyphs available from the installed toolboxes appear under
this menu. These glyphs are classified by category and sub-category.

User defined

5. Pick the User defined operator under the Glyphs menu in the category
Input/Output, sub-category Data Files.

6. Open the pane of the operator and use the File Browser tool to select the
file myimage.ascii.

7. Close its pane.

Data Object Info

8. In the same way, choose the Data Object Info glyph, which is located
in the Glyphs menu under Input/Output and Information. Place it to the
right of the User defined glyph.

Category and sub-category of a glyph

Tip: To find which category and sub-category a glyph belongs to, open

its pane and click on the pulldown menu. Select Object Info....
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10.
11.

12.

13.

A pop-up window shows the attributes related to the glyph. Click in the
window to position the cursor, and use the down-arrow key to see the text
at the bottom.

< Print File Information

Frint File Infarmation

| Input I

|_| Suigu

Running Data Object Info on an ASCII file

. In the pane of the Data Object Info glyph, check to see that the Qutput

parameter is diabled and close the pane.
Connect the two glyphs together.

Execute the Data Object Info glyph to extract the header information
of the ASCII data file format myimage.ascii.

Open the Green Console Button and verify that its dimensions are indeed
10 pixels in the width dimension and 5 pixels in the height dimension.
Also observe that the Storage Format is recognized as ASCII and that
each pixel Data Type is Double, which is a double-precision floating point
format. Below is an excerpt of the output of the Data 0bject Info glyph.

Name: myimage.ascii

Storage Format: ascii

-- Value Data --

Data Type: Double

Size: Width=10, Height=5, Depth=1, Time=1, Elements=1

H B H R

File Viewer

The File Viewer glyph, which corresponds to the khelp operator, is used
to visualize ASCII files.

Pick up the File Viewer glyph, located in the Glyphs menu under In-
put/Output and Information and place it below the Data Object Info

glyph.
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14.

15.

16.

17.

Connect its input to the output of the User defined glyph and run it. By
doing this you display the actual ASCII contents of the myimage.ascii
file.

4 ¥iewing "myimage.asci”

12345678310

myimage.ascii

Close

File Viewer in the output of Data Object Info

Recall that the Data Object Info glyph has an optional output file.
When disabled, it sends its output to the Green Console Button. Now
use another File Viewer glyph to view the output file generated by the
Data Object Info glyph when it is enabled.

Duplicating a glyph

To duplicate a glyph, first select it by clicking on it and observe a color
change from light to dark grey. Then, select the duplicate option in the
Edit menu. A short cut for this operator is <Ctrl-D> or the correspon-
dent icon button located in the command bar.

Duplicate the File Viewer glyph and place it to the right of the Data
Object Info glyph.

Connect the output of the Data Object Info glyph to the input of the
File Viewer glyph.

Note: This connection is yellow, meaning that you have to execute the
Data Object Info glyph again. The last time you ran it, it sent the file
output to stdout as the output parameter was disabled.

Rerun the Data Object Info glyph and run the File Viewer glyph.
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Editimage on ASCII file

To verify that the ASCII data can be displayed as an image, use the object
editimage in VisiQuest.

18. Choose the Edit Image glyph, which is found under Visualization and
Interactive Image Display.

19. Place it below the User defined glyph and connect its top input connec-
tion to the output of the User defined glyph and run it.

Observe the small size of the image in the editimage window, due to the
fact that there is a one-to-one mapping between the pixel stored in the
image and the pixel displayed.

20. As you have done before, select the View and View | Pixel Values

buttons to perform a detailed visualization of the image.

21. Save this workspace under the name importing-ascii.wk.

4 EDIMMAGE

File View Select Options

< Editimage: Zoom

Zaom

4 Editmage: Pxel Value:

Zoom Factor:
Pixel Yalues

Width |7 F 5

Height | g9 F

Update mode: i _
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3.2 Exporting Data to ASCII

This section explains how to export data to the ASCII format for re-use in
other programs. First, you will generate a 1D Gaussian data file, using the 2D
Gaussian glyph, and visualize the data by using the Display 2D Plot glyph.
Then, you will be shown how to convert data to the ASCII file format, visualize
the ASCII data, and save it in the file gaussian.txt in the home directory.

Generating 1D Gaussian data

1. Clear the previous workspace and find the 2D Gaussian glyph (category
Input/Output, sub-category Generate Data), and fill in the following pa-
rameters in its pane:

Parameter Value
Width 1
Height 21

Peak location along Width (X) 0
Peak location along Height (Y) 10

Variance along Width 1
Variance along Height 4
Correlation coefficient 0
Peak Value 1.0
Select Data Type: float

This generates a Gaussian data file as a 1D signal in the height dimension
with 21 samples. The maximum position of the Gaussian bell (peak) is at
position 10 with value 1, and the spread of the Gaussian data around the
peak is given by its variance of 4.

2. Retrieve the Display 2D Plot glyph (Visualization, Plot Display) and
connect its input to the output of the 2D Gaussian glyph.

3. Execute the 2D Gaussian and the Display 2D Plot glyphs to see the
shape of the Gaussian data created.

Converting to ASCII

The file conversion routines are integrated in the Supported Formats
glyph. Below is its pane, from which you can verify the formats supported
by VisiQuest. Remember that all these formats are accepted directly as
input to any operator.
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Bl ‘Cunversi:n Between the Formats Supporied in Khoros 2

Conversion Between the Formats Supported in Khoros &

Options

| Input INar.'tmp!i0251 A8

Specify Output Data Format:

[~ JFEG
[~ PNM
[ Pcx
v asci
[ avs
[~ arF
| Raw

[ e

[ KDF (Khoros 2.0 Data Format)
[~ wIFF (Khoros 1.0 Image Format)
[~ %BM
[~ xwD
[ %PM

|_ 3un Raster

I

| Output | fvarftmpliozs1a.9

4. Retrieve the Supported Formats glyph from Input/Output, Exzport Data,
connect its input to the 2D Gaussian glyph, and select ASCII format in

its pane.

5. Now, choose the File Viewer glyph from Input/Output, Information and
connect it to the output of the Supported Formats glyph.

6. Run the Supported Formats and the File Viewer glyphs to verify the

converted ASCII data file.
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4 Puiploi2: varimpiic251A 8 Ll Viewing “Narfmpioes1a 9 (|

RIS 3,726655-06
4, 00853605
0,000335463
0,00216743
0011109
0.0435363
0.135335
0.324652

0, 508531
0,882497

1

0,882497
0,606531
0,324652
0,135335
0,0439363
0,011103
0,00218743
0,000335463
4,00653e-05
3, 726E5e-06

fyarimpfio2s1A.9

Close

zD % Display
Gaussian 2D

Supported File
Formats Viewer

Saving the data to an explicit file

In the VisiQuest workspace, data is represented by connections between
the glyphs, and their names created automatically in a temporary direc-
tory.

7. Save the ASCII Gaussian data by clicking on the connection between the
Supported Formats and File Viewer glyphs. A connection window pops

up. Select Save Data to File and click on the button.
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< |Choose Dialog for cantata

<

fvartmpdioZsl 4.9

Delete Connection

Connection Optians

e Data to File

Standard Unix Files (file)
temary Mapped Files (mmap)
Shared Memary Files (shm)
Standard Stream FIFO (stream)

Unix Damain Socket (socket)

‘ QK | Cancel

Another window to create filenames appears.

8. Fill in the filename gaussian.txt.

Note: Don’t forget to click on the button, otherwise the file will not

be saved.
4 Query Dialog for cantata |l
PaN
g Flease enter filename
~
Filename: | yaussian.ixt |’

Ok

Cancel

9. Save this workspace under the name export-data-gaussian.wk and clear

the workspace.

ASCII data and spreadsheets

The created file gaussian.txt can be exported to many other software pack-
ages that read ASCII data, the simplest file format for data exchange. Most
spreadsheets can further process ASCII data and plot it.

Using gnuplot to generate PostScript output

For instance, we use gnuplot to plot data and generate PostScript files suitable
for hardcopy material. PostScript is a standard file format for printers. There



56 Import and Export Data

are two types of PostScript file formats: regular PostScript (PS) and encap-
sulated PostScript (EPS). The first is used for final output and EPS is used
for insertion of data in other files. In VisiQuest and 2001, PostScript is only
supported for the generation of PostScript output images.

Gnuplot

gnuplot is a command-line-driven, interactive plotting utility widely available
in UNIX systems. If you don’t have it installed, you can download it from
http://www.cs.dartmouth.edu/gnuplot_info.html.

The following gnuplot commands plot the ASCII file gaussian.txt and
write the output in EPS PostScript in the file gaussian.eps.

At the command line, type in the following commands: !

%gnuplot

gnuplot> plot "gaussian.txt" with linespoints
gnuplot> set terminal postscript eps
gnuplot> set output "gaussian.eps"

gnuplot> replot

gnuplot> quit

"gaussian,txt" -—
0.9 s

0.8
0.7
0.6
0.5
0.4
0,3
0,2
0,1

You can view the PostScript plot with the tool ghostview, a popular
PostScript visualizer. If you don’t have it available in the system, you can
download it from http://www.cs.wisc.edu/~ghost/ghostview/.

%ghostview gaussian.eps

Most word processing packages support the insertion of PostScript data
within the text. All the figures in this tutorial were inserted as PostScript

IFor version VisiQuest 1.0.0.0, use an editor to remove the last line of file gaussian.txt
which contains the spurious string “<br>".
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files.

3.3 Exporting Images to PostScript Format

PostScript is a hardcopy format and, as such, it does not make sense to use this
file format for data exchange. VisiQuest includes an operator to convert images
to PostScript format.

In this section you will learn how to create a workspace to convert an im-
age to PostScript format and then visualize it with the ghostview tool inside
VisiQuest.

1.

Clear the previous workspace and retrieve the Images (Misc) glyph (In-
put/Output, Data Files). Open its pane, choose the Spanish Sea Gull
image, and close the pane.

. Choose the putimage operator, which corresponds to the Display Image

glyph in VisiQuest. The Display Image glyph is in category Visualiza-
tion, sub-category Non-Interactive Image Display.

. Place the glyph to the right of the Images (Misc) glyph and connect its

first input to the Images (Misc) glyph. Run the Display Image glyph
to visualize the gull image.

. Now, find the Postscript glyph (Input/Output, Hard-Copy Output) and

place it below the Display Image glyph. Connect it to the Images (Misc)
glyph and open its pane.

. Select Encapsulated Postscript, close its pane, and execute its glyph.

This makes the output suitable for inclusion in other documents.

Interfacing VisiQuest with third-party programs

To display the generated PostScript file, we use the ghostview tool that
we used to visualize the PostScript file of the Gaussian plot. This time,
however, we use ghostview directly from VisiQuest. There are many
ways to interface third-party programs into VisiQuest. This example is
the simplest.
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6. Find the Command Icon glyph (Program Utilities, General) and place it
to the right of the Postscript glyph.

This glyph is a general interface program that uses stdin and stdout stan-
dard file connections. Any program which can read from stdin and write
to stdout can be interfaced with the Command Icon glyph. In this case, to
make ghostview read from stdin you have to use the syntax ghostview -
which is an option in ghostview for reading from stdin.

7. Open its pane and disable the stdout option, as there is no output from
this glyph.

8. In the Command field, type in ghostview - and close the pane.

4 Interface Used to Runa Generic Command

Interface Used to Run a Generic Command

vV B stdin v stdout B

Command | ghostview -

Changing the name of a glyph

VisiQuest allows you to change the name of a glyph icon to better doc-
ument, your workspace.

9. Change the name of the Command Icon glyph to Ghostview by clicking on
the glyph name, and entering the name Ghostview in the new Icon Name
window.

4+ Query Dialog for cantata |_I.|.|
PN

L Please enter new lcon MName

~

Mode Name: | Ghostview |,

Ok Cancel
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10. Connect the input of the Ghostview glyph to the output of the Postscript
glyph.

11. Execute the Ghostview glyph and verify that the PostScript file was gen-
erated properly.

12. Save the EPS file under the name gull.eps by clicking on the output
connection of the Postscript glyph. This EPS file is ready for insertion
in most word processor packages.

13. Save the workspace under the name gull-postscript.wk. A screen dump
of this workspace is shown below.

3.4 How To Export Images to Other Formats

You normally export images with the Supported Formats glyph used in section
3.2. The formats understood by VisiQuest are listed in the Supported Formats
pane. VisiQuest does not support every data file format. For those that are
not supported, there are software packages available that allow you to create an
interface with VisiQuest. In this section, we will examine how xv can be used
to generate other file formats.

3.5 Interfacing to xv

xv is a widely used software package to manipulate and visualize images. It
supports a variety of file formats such as GIF, JPEG, TIFF, and BMP that are
not supported by VisiQuest. GIF and JPEG are used in many HTML docu-
ments for World Wide Web (WWW) publishing and TIFF is used for desktop
publishing. xv is available at ftp://ftp.cis.upenn.edu/pub/xv/.
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PNM image format

Among those formats supported by VisiQuest, PNM and Sun Raster are widely
used. PNM, one of the simplest image file formats, was created in association
with the software PBMPLUS (which can be found at
http://www.acme.com/software/pbmplus/). PNM supports three pixel data
types: PBM for bit-type images, PGM for unsigned integer images, and PPM
for color images.

xv and gif

1.

Clear the previous workspace. Start by finding the Images (Misc) glyph
under Input/Output, Data Files and in its pane select the image Spanish
Sea Gull.

Find the Supported Formats glyph (Input/Output, Export Data). Place
it to the right of Images (Misc) and select the PNM file format in its pane.
Connect its input to the Images (Misc) glyph.

Now, find the Data Object Info glyph (Input/Output, Information) and
place it to the right of the Supported Formats glyph. Open the pane,
make sure its Qutput option is disabled, and close the pane. Connect its
input to the Supported Formats glyph and execute it.

Click on the Green Console Button of the Data Object Info glyph after
it runs and verify that the Storage Format of this file is PNM.

Name: /tmp/io94.1c

Storage Format: pnm

Color Space Model: KGREY

-- Value Data --

Data Type: Unsigned Byte (4)

Size: Width=256, Height=256, Depth=1, Time=1, Elements=1

H H HF HHH

Place the Command Icon glyph (Program Utilities, General) below the
Data Object Info glyph. Open its pane, disable the stdout option, and
type in the string xv - in the Command field, and close the pane.

Change the Command Icon glyph name to xv by clicking on the icon name.

Connect the input of the xv glyph to the output of the Supported Formats
glyphs.
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Using xv to save other image data file formats

8. Run the xv glyph.

Once xv is running, the gull image is displayed in its window.

9. Click on the image with the right-hand mouse button to display the xv
control window. Click on the button and then select the GIF file

format. Enter the filename gull.gif and click on the button. This
GIF file is ready to be included in an HTML document.

10. Exit xv by clicking on the button of the xv control window.

11. Save the workspace under the name xv.wk and execute the entire workspace.

Importing other image data file formats

You can also use xv to import data formats that are not supported by VisiQuest.
You can display the image you want to import by using xv and then save the
file in PBM format (select the color, grey, or bitmap option). This PBM file is
supported by VisiQuest.

3.6 Reading Data in Binary Format

For reading data files in binary format where the complete specification is un-
known, VisiQuest provides a very flexible tool, the Import Raw glyph. To use
this glyph, adjust parameters until you find what you want on a trial-and-error
basis.

In this experiment, we will illustrate how to read a file with a partially known
raw binary data format. You will read the file Nerve Cell by using the Import
Raw glyph. Although we know that this file is in the KDF file format with size
256 x 256, we will suppose that you know that the file is in binary raw format



62

Import and Export Data

with 256 x 256 pixels stored as unsigned bytes in raster order, i.e., from left to
right and from top to bottom. You also know that the file has a header stored in
the beginning of the file, but you don’t know its size. The header of an image file
contains information about the file. This scheme is common to many standard
file formats.

1.

Clear the previous workspace and find the Images (Misc) glyph (In-
put/Output, Data Files), then select the image Nerve Cell in its pane.

Choose the Import Raw glyph (Input/Output, Import Data) and connect
its first input to the Images (Misc) glyph.

Find the Edit Image glyph (Visualization, Interactive Image Display)
and connect its first input to the output of the Import Raw glyph.

Open the Import Raw pane and set both parameters Width and Height
to 256. Leave Offset or skip (bytes) as 0.

This operator is very flexible. You specify the number of pixels to read,
and the order they are stored in each dimension. You also specify the
format each pixel is stored in and at which offset the pixels are stored. In
this case the Import Raw glyph will read the file as 256 x 256 pixels stored
as bytes starting from the very first byte of the file.

Run the glyphs. The display output in Edit Image is shown below.

File View Select Options Help

(ed2x 78= 74)

Note that the image is wrapped shifted to the right. Also note that the
top few lines on top of the image appear as black with noise. This is
the typical effect found in reading raster data where the offset to skip the
header information is not correct. You need to estimate how many pixels
there are in these noise lines. Next, you will use the Edit Image tool to
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zoom the image and find the coordinates of the first valid pixel in the
image.

6. Open the View Zoom and View Pizel Values tools of Edit Image. Po-
sition the mouse at coordinate (91 x 2) and verify that this is where the
pixel data starts. A screen dump of the Zoom and Pizel Values tools is
shown. The first pixel value is 202.

If the pixel data starts at coordinate 91 x 2 and the pixels are stored in
the width first, it means that the header has a size of 2*¥256 + 91.

4 Editimage: Pixel Yalues Llﬂ -+ Editimage: Zoom Lﬂ

Pixel Yalues Zoom Cloge

Width 7 5 show Color? ¥ Zoam Factor:

Height |9 5 Update mode Button Press

Location Marker Type:
Update mode: Button Press 4 i
[m]

7. In the pane of the Import Raw glyph, change the Offset or skip (bytes) to
2x256 + 91.

Note: The numerical parameters can be entered as expressions. Later you
will see that VisiQuest supports the use of variables in the expressions.

Offset ar skip (bytes)|2*256 + 91

8. Rerun the glyphs and note that the image is displayed correctly. Verify
that the pixel (0,0) of the image has value 202.

9. Save this workspace under the name importing-raw.wk.

In this section you learned how to import raw data in binary file format.
VisiQuest has a very flexible operator to read this kind of file. You used a
known data file format to illustrate the input of binary raw data format. In the
next section, you will learn how to export data to other formats that do not
have the same features as the VisiQuest Data Format.
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3.7 Data Normalization

When exporting data, you must be aware that not all file formats fully support
the features of the VisiQuest Polymorphic Data Model. In this model, a pixel
value can be stored in many data types, such as bit, unsigned byte, floating
point, etc. Most image file formats do not support this flexibility. In this
section you will export an image which has negative and positive pixel values
to the Sun Raster file format, which supports pixels in the range 0 to 255.

1. Clear the previous workspace, retrieve the Images (Misc) glyph (In-
put/Output, Data Files), and select the Big Truck (signed short) image.

2. Find the Data Object Info glyph (Input/Output, Information), connect
it to the Images (Misc) glyph. Disable its Quiput option in its pane, and
run it to verify that the pixel Data Type is short. Short is a signed 16-bit
format capable of representing pixels from values -32,768 up to 32,767.

# Comment:

Image produced by a long wave infrared sensor of
an M35 truck.

End Comment

Storage Format: kdf

-- Value Data --
Data Type: Short (8)
Size: Width=596, Height=356, Depth=1, Time=1, Elements=1

H H H R HH

3. Select the Statistics glyph (Data Manip, Analysis & Information).
Connect it to the Images (Misc) glyph and run it to verify the mini-
mum and maximum pixel values within the image. An excerpt of the
output of the Green Console Button of the Statistics glyph is shown
next.

FILE: m35_lwir.kdf

Object Dimension: w=596 h=356 d=1 t=1 e=1
Mean: 490.116

Std Dev: 374.813

Minimum: -539

Maximum: 2329

Notice that the minimum value is negative (-539) and that the maximum
value of 2,329 is well above the usual 255 scale.
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4. Select the Display Image glyph (Visualization, Non-Interactive Image
Display) and connect its first input to the Images (Misc) glyph. Execute
the glyph and move the mouse pointer over the image to verify that dark
areas are assigned to negative pixel values and white areas are the highest
positive values.

In this way Display Image assigns grey-tones to pixel values. To the
minimum pixel value in the image, it assigns the black color, while it
assigns the white color to the maximum pixel value, creating a linear
grey-scale colortable that assigns intermediate grey-tones to all other pixel
values.

(143x 26=-185)

Next, you will convert this image directly to the Sun Raster format and
verify that it does not work as expected.

5. Access the Supported Formats glyph (Input/Output, Export Data) and
select Sun Raster format. Connect its input to the Images (Misc) glyph.

6. Run the Supported Formats glyph and observe that an Green Console
Button appears. Open the Green Console Button and verify its contents

Sun Raster format output :
- casting value data to Unsigned Byte for storage.

The conversion routine states that the pixel values are stored in the
Unsigned Byte in the Sun Raster format. Casting a value to a smaller
data type storage means that a truncation operation was done. In this
case pixel values outside the range 0 to 255 may be lost.

Verify how the images were converted in the Sun Raster format by dis-
playing it.
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7. Duplicate the Display Image glyph and connect it to the output of the

8.

10.

11.

12.

13.

Supported Formats glyph.

Run the Display Image glyph and verify with the mouse that the image
has pixels ranging from 0 to 255, however the truncation process corrupted
the image.

4 Putimage: ivarimp/io2514.1b |l

To adjust for the truncation process in the exported data file, it is possible
to normalize the data in a range that fits in the unsigned byte data storage.

Select the Normalize glyph (Data Manip, Data Conversion) and connect
its input to the Images (Misc) glyph.

Duplicate the Supported Formats glyph and connect it to the Normalize
glyph.

Duplicate the Display Image glyph and connect it to the Supported
Formats glyph.

Execute the glyphs and verify that the image is displayed correctly.

Save the workspace under the name normalization-truck.wk.
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To repeat, it is important to realize that in exporting data to other formats,
information can be lost. In the case of the normalization example above, the
original pixel values were lost as well as the dynamic range of the data. Origi-
nally, the data ranged from -539 to 2,329 (range of 2,869); after conversion the
data ranged from 0 to 255 (range of 256).

3.8 More About the Data

Statistics tool

An important tool with which to gain insight on the data is the statistic mea-
surement operator, with basic information on minimum, maximum, and mean
values. VisiQuest provides the kstats operator, which is activated by the
Statistics glyph.

Using variables in VisiQuest

This section will explore the Statistics tool and the use of variables in VisiQuest.
Variables are an important feature of a visual program, since they can replace
numeric arguments in the panes. The workspace, described below, thresholds an
image by its mean value. A binary image is generated from a grey-scale image
based on the criterion that each pixel value above the mean value is assigned
the value 1. All other pixels are assigned the value 0.

1. To begin, clear the previous workspace and find the Images (Misc) glyph
(Input/Output, Data Files). In its pane, select the image Modulation
Transfer Function.
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2. Find the Display Image glyph ( Visualization, Non-Interactive Image Dis-

play) and place it above and to the right of the Display Image glyph.
Connect its first input to the Display Image glyph and execute it.

Il

This image is rather interesting, serving to measure how the contrast sen-
sitivity of the human eye depends on the spatial frequency. The image is
composed of a 2D signal with increasing frequency on the width direction
and increasing amplitude (contrast) in the height direction. Looking at
this image, we realize that our perception is attuned to medium frequen-
cies, as opposed to low or high frequencies.

. Choose the Statistics operator Data Manip, Analysis € Information.

Place it below the Images (Misc) glyph and connect its first input to the
output of the Images (Misc) glyph.

. Execute the Statistics glyph. Its output goes to the Green Console

Button. Click on it to reveal the information. Its result is reproduced
below. Note that this image has minimum and maximum pixel values of
0 and 255, respectively, and a mean value of 124.14.
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Object Dimension:

Minimum: O
Maximum: 255

Positive Integral:

First minima at location:
First maxima at location:
Total Integral: 3.

w=512 h=512 d=1 t=1 e=1

Mean: 124.142
Variance: 1004.15

Std Dev: 31.6883

RMS: 128.122

Skewness: -0.00614449
Kurtosis: 3.38875

w=125 h=511 d
w=173 h=511 d=

0 t=
0 t=
2543e+07

3.2543e+07

Negative Integral: O
Total Contributing Points:
Contributing Positive Points:

262144
262134
Contributing Negative Points: O
Contributing Zero-Valued Pts: 10

5. Close the Statistics text window.

Variables

The VisiQuest visual language supports the use of expressions in the pa-
rameter fields of the operators. Valid expressions may include variables,
standard arithmetic operators, and logicals, as well as predefined constants
and functions. The variables can be calculated at run time via mathemat-
ical expressions tied to data values or control variables, or interactively
set by the user.

Assigning to a variable: Print Stats

Use the Print Stats glyph to assign the mean value of the data file to a
variable named mean.

. Find the Print Stats glyph (Data Manip, Analysis € Information) and
place it below the Statistics glyph in the workspace.

. Open its pane and enable the Mean Calculation option. The default vari-
able associated with this evaluation is mean.
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8.

10.

Mean [« |mean

Wariance |_ Wz g

Close the pane and connect its input to the output of the Images (Misc)
glyph and execute the glyph.

Variable subform

The effect of the execution of the Print Stats glyph is on the value of
the variable mean. To verify that the glyph has executed correctly, check
for the new value of the mean variable.

The Variables subform is used to display and define variables and evaluate

expressions.

Open the Variables subform (Workspace, Variables...).

Notice that the mean that you are working on is listed in the Variable list
at the bottom left of the Variables subform, that it has been defined as a
double precision numer and that its value is displayed (mean = 124.142).
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11.

12.

13.

+ Variables Ll

Define Variables ¢ Evaluate Expressions | Help | | Close |

Areal MainWorkspace

Evaluate | Evaluation Result: 124.142

Yariable Type Yalue

mean double 124142

Yariahle Definition:

Celete Selected Wariahle

Close the Variables subform.

Using variables in expressions

With the mean variable you can now do a thresholding operation on the
image, by using its value as the threshold parameter. Thresholding is a
widely used technique to binarize data. In this example, all pixel values
of the image that are above the threshold are assigned the value 1 and
all others, the value 0. In VisiQuest, many operators implement this
thresholding function. The “>” operator is being used in this example.

Select the “>”operator, which is located in Arithmetic, Comparison Op-
erators and place it below the Print Stats glyph. Open its pane, type in
the string mean in the Constant parameter box, change the TRUF value
to 255, and close its pane.

Connect the output of the Images (Misc) glyph to the input of the
“>”olyph and execute it.
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14. Visualize the result of thresholding by using another Display Image glyph
connected to the output of the “>"glyph. You may use the duplicate
facility to get another Display Image glyph.

The pixels in this thresholded image are white wherever the pixel values
are below the value 124.142 in the original image.

4 Putimage: fvariimp/io2514 2c

File

(1435 67 = 255)

Glyph control connection

Note that the “>”glyph has to be executed after the execution of the
Print Stats glyph. Observe that there is no connection between these
two glyphs. VisiQuest provides a control connection mechanism between
glyphs to synchronize their execution. These control connections are cre-
ated by clicking on the small grey boxes above the data connections in the

glyphs.
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15. Connect the output control connection of the Print Stats glyph to the
input control connection of the “>"operator. Note that the control con-
nections have a different color than the data connections.

16. Change the image in the Images (Misc) pane to Spanish Sea Gull, then

reset and rerun the entire workspace by clicking on the VisiQuest
button.

Note: It is important to reset the workspace when using VisiQuest before
rerunning the workspace.

17. Save the workspace under the name threshold-mean.wk.

Conclusion

In this chapter, you have seen how to import data to and export data from the
VisiQuest environment. You worked with the ASCII data format and generated
hardcopy output using PostScript files. You learned how to interface VisiQuest
to third-party software packages as well as the basic concepts of inserting images
and plotting in text documents.

You have advanced your knowledge of the data model and image file formats,
working with raw binary images and data normalization issues.

In VisiQuest, you were introduced to variables and to the glyph synchro-
nization mechanism.

Next, you will continue to explore the data model and learn how to repre-
sent colored images. You will work with the map and mask segments of the
Polymorphic Data Model.
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Chapter 4

Polymorphic Data Model

The experiments in earlier chapters required only the value segment of the
Polymorphic Data Model. This chapter will expand the discussion of the data
model to include the map and mask segments. First, we will explore how color
images are built and represented with and without the map segment, followed
by the use of the mask segment to define regions of interest in an image.

4.1 RGB Color Model

Color images can be represented in many color models. The color model used in
monitors is the RGB, where each pixel has three components: Red, Green and
Blue, which when combined can generate most of the existing colors. VisiQuest
stores the color model as an attribute associated with the data. There are many
color models supported by the system and the selection of the appropriate model
is application dependent.

Elements dimension: RGB

In the VisiQuest Polymorphic Data Model, the color components are stored in
the “elements” dimension of the value segment: Element 0 is for red, Element 1
for green, and Element 2 for blue. To experiment with color, generate an RGB
color image by stacking in the element dimension three monochrome images of
translated circles.

In this section, you will learn how to create a colored image using the RGB
model. In the workspace described in the following pages, three circle images,
decentralized in reference to each other, are stacked together in the elements di-
mension of the Polymorphic Data Model. The image created has eight different
colors.
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Circle Image

1. Clear the previous workspace and place the Circle Image operator (In-
put/Output, Generate Data) in the workspace. Open its pane and fill in
the following parameters:

Parameter Value
Rows: 128
Columns: 128
Diameter of circle: 60

X coordinate of center: 64
Y coordinate of center: 64

Background level: 0
Foreground level: 255
Output data type: UNSIGNED BYTE

Older version of VisiQuest

This operator was developed for VisiQuest 1.0.5 (K1) which used a differ-
ent data structure than VisiQuest. In the older version, the data model
was different: Rows corresponds to height and Columns to width in the
new system.

2. Close and run the glyph.

3. Find the Display Image glyph ( Visualization, Non-Interactive Image Dis-
play), place it above and to the right of the Circle Image glyph, connect
and execute them to visualize the circle image.
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Generating three translated circles

We need three translated images, each translated by 20 pixels in the follow-
ing directions: 0, +120, and -120 degrees, which correspond to 0, 2*pi/3,
and -2*pi/3 in radians. The following table shows the offsets for translat-
ing the circle in the width and height dimensions.

First image | Second image | Third image
Width Offset: | 20xcos(0) 20*cos(2xpi/3) | 20*cos(-2%pi/3)
Height Offset: | 20*sin(0) 20*sin(2xpi/3) | 20*sin(-2*pi/3)

4. Find the Translate operator (Data Manip,Reorganize Data). Duplicate
the glyph twice and place all three glyphs one above the other to the right
of the Circle Image glyph. Connect their inputs to the output of the
Circle Image glyph.

Expressions and functions in panes

5. Open their panes and modify the offset parameters according to the table
shown above. Remember that the parameter field can accept expressions

involving functions such as cos and sin and special constant values such
as pi (m = 3.1416).
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|F Width Offset | 20 * cos(0) f

|v* Height Offset[20 * cos{0) | #

Appending 2D images
Next you will stack together the monochrome images, by using the Append
glyph.

. Find the Append glyph (Data Manip, Size & Region Operators) and place
it to the right of the three Translate glyphs. In its pane, select Elements
to stack the images along the elements dimension.

Stack ohjects along following dimension:

[7 width [ Height [ Depth [ Time W Elsments

. Connect the output of the three Translate glyphs to the first three inputs
of the Append glyph. Run the three Tranlate and the Append glyphs.

Stacking images

. Use the Data Object Info glyph (Input/Output, Information) to verify
that the output image of the Append glyph has three elements of size 128
x 128 and no color model attribute. An excerpt of the output of the Data
Object Info glyph is shown below.
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10.

11.

# Color Space Model: 0 (invalid)

# -- Value Data —-
# Data Type: Unsigned Byte (4)
# Size: Width=128, Height=128, Depth=1, Time=1, Elements=3

Visualizing with Animate

. Choose the Animate glyph (Visualization, Interactive Image Display),

connect it to the Append glyph, and sequence through the three image
frames along the elements dimension. Since there is no color model yet,
the image is treated as three independent grey-scale images.

Setting the color model attribute

To interpret this three-element data set as an RGB image, the color model
attribute must be set to the RGB Color Model.

Locate the Set Attribute glyph (Data Manip, Object Attributes). Place
it to the right of the Append glyph and connect its input to the output of
the Append glyph. Open the pane and at its lowest portion, enable the
Colorspace option and select RGB in the associated pulldown menu. Close
the pane and run it.

Data Object Color Attributes

Tip: The size of the Set Attribute pane is large. If you have difficulty

in closing its pane because the button is not on the screen, click
again on the top-left corner of the glyph.

Primitive color combination

Visualize this new image with a duplicate copy of the Display Image
glyph connected to the append glyph. Navigate with the mouse over the
displayed image and observe that there are three pixel values (R, G, and
B) for each coordinate. Each color can be a point in the RGB color model.
Red, green, and blue are known as the primary colors. These colors can
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be combined to produce secondary colors. By placing your cursor over the
image, you can identify the following colors:

Color Red Green Blue
Black 0 0 0
Blue 0 0 255
Green 0 255 0
Red 255 0 0
Yellow 255 255 0
Magenta 255 0 255
Cyan 0 255 255
White 255 255 255

Tip: If the text window of the Display Image window is not wide enough
to show the pixel values, resize the window.

The final workspace for this exercise is shown below.
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4 ANIMATE 4 Putimage: varimpio2

File

File Select Options
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Animation Frame Mumber: 1
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12. Save the workspace under the name color-circles-RGB.wk.

4.2 Other Segments in the Polymorphic Data
Model

As mentioned before, earlier examples of the Polymorphic Data Model focused
on the “value” data segment. We will now examine the “Map” segment. In
other image data models, the map segment is often referred to as the colortable.

4.3 Map Segment

The pixel values of a digital image can be a single scalar value or a vector with
its values normally stored in the elements dimension. Recall that in RGB color
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images, each pixel has three elements, corresponding to the colors red, green,
and blue.

True Color and Indexed Color

There are two data schemes used to represent the pixel values within an image.
One is called “True Color,” when it uses the explicit color values in the value
segment, and the second method is called “Indexed Color,” when each pixel
value is an index to a table in the map segment. Each entry in the table can
be associated with one or more values. The length of the table can be any
size, depending on the index values within the image. This table, stored in the
map segment, has many different names, such as colortable, color palette, LUT
(look-up table), mapping table, colormap, etc.

MAP Data
value points index into the value data
map height A 158 lgftor
E /, // //
) 4
O e ————————— -7 eoeo
=
Q)
IS
E VALUE Data

map width

The advantages of using the map segment are mainly three:

Image Compression. In a True Color image in the RGB model, each pixel
requires three values for storage. If a colortable is used, each pixel requires
one index value and the map segment requires a table of width 3 and height
given by the number of different colors in the image. An Indexed Color
image in the RGB model, represented by a map segment, is approximately
1/3 the size of the correspondent image stored in the True Color format.

Processing Speed. If an image is represented by using the map segment, all
pointwise operations that use a single operand can be executed by process-
ing the table in the map segment. The map segment is in general much
smaller than the image.

Hardware Support. Most color monitors and frame grabbers have a col-
ortable in hardware so that the colortable structure closely matches the
hardware model, allowing single operand pointwise operations to be pro-
cessed in hardware.

Experimenting with map segments

In the following experiment, we will create an Indexed Color image, by modifying
the previous color-circles-RGB.wk workspace. The idea is to build the three
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monochrome images to a single index image with 8 colors. We then manually
build an ASCII colortable to be used as the map segment of the Indexed Color
image.

The workspace described in the following steps is shown at the end of this
section. You may refer to it to help in its creation.

1.

6.

Reload the color-circles-RGB.wk workspace after clearing the previous
workspace.

. Delete the Data Object Info, Animate, Set Attribute, and Append

glyphs. You can delete a glyph by selecting the glyph and then click-
ing Delete in the Edit menu (short-cut <Ctrl-B>).

. In the pane of the Circle Image glyph, change the Foreground Level to 1.

Multiplying the images

Multiply the pixel values of the second translated image by 2 and the third
translated image by 4. The reason is to get a final combined image with
8 different pixel values given by the combination of weighting the three
circles by 1, 2, and 4.

Select the Multiply glyph (Arithmetic, Two Operand Arithmetic) and
place it to the right of the second Translate glyph. In its pane, set the
parameter Real Constant to 2, and connect the first input of the Multiply
glyph to the second Translate glyph.

. Duplicate the Multiply glyph, place it below the previous Multiply

glyph, and connect it to the third Translate glyph. Change its Real
Constant parameter to 4.

Adding the images together

Find the Add glyph (Arithmetic, Two Operand Arithmetic) and place it
above and to the right of the first Multiply glyph. Connect the first input
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10.

to the first Translate glyph and the second input to the first Multiply
glyph.

. Duplicate the Add glyph and place it to the right of the first Add glyph.

Connect its first input to the Add glyph and the second input to the second
Multiply glyph. Connect the output of this Add glyph to the Display
Image glyph that was already in the workspace.

. Open the pane of the Display Image glyph, and set the Normalization

Method to Range: Maximum.

Mormalization MMethod Range: Maximum |f

. Save the workspace as greyscale-circles.wk before going on to the next

part of the experiment.

The grey-scale image with eight grey-levels

Run the workspace. The final displayed image is a grey-scale image with 8
different pixel values: 0 to 7. To enhance the displayed image, click on its

button and select -3*(std.dev) <= values <= 3*(std.dev)

as the Normalization Method.
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< Putimage: /resea |_|_|_|

File
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The purpose of this experiment is to use the pixel values of the grey-scale
image just created as an index to a colortable. The colortable must have
8 entries and each entry must have three values, the red, green and blue
components of the indexed color. Next, the colortable will be created and
then used in the grey-scale image.

Creating an ASCII colortable

The colortable will be built from an ASCII image with size of width = 3
and height = 8.
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11. Create an ASCII colortable file named map8.txt by using a text editor
such as xedit.

%xedit map8.txt

12. Enter the following pattern:

0 0
255 0
0 255
255 255
0 0
255 0
0 255
255 255

0
0
0
0
255
255

255
255

13. Save it and quit xedit.

Reading the ASCII colortable in the map segment

14. Find the User defined glyph (Input/Output, Data Files) and place it
below the Circle Image glyph. In its pane use the file browser tool to
select the ASCII file map8.txt created by the text editor.

15. Find the ASCII to Map glyph (Input/Output, Import Data), place it to
the right of the User defined glyph and connect to it. In its pane change
the following parameters:

Parameter Value
MAP WIDTH: 3
MAP HEIGHT: 8

This ASCII to Map glyph reads the ASCII file and stores the table in the
map segment of the VisiQuest Polymorphic Data Model.
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Checking the data header of a map segment data file

16. Use the Data Object Info glyph (Input/Output, Information) to verify
how this segment is stored in the KDF data.

An excerpt of the data file header is given below. Note that the data file
has just one segment, identified as “Map Data” with width = 8 and height

=34
# Storage Format: kdf
# -- Map Data —-
# Data Type: Double (1024)
# Size: Width = 3, Height = 8, Elements = 1,
# Depth Dimension = 1, Time Dimension = 1

Displaying a map segment

17. To display the colors of a map segment, use the Display Palette glyph
(Visualization, Color Map Display & Manipulation) connected to the
ASCII to Map glyph.
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The display shows the 8 colors stored in the map segment. The color
indexes are implicit and range from 0 to 7.

4 |Putdata: varimp/ic2514 .4

File

Color images and map segment
There are three basic ways of dealing with images and map segment:

e Use the map segment as a color map in the display. This is an Index
Color image with an external map segment.

e Store the map segment in the same file together with the value seg-
ment. This is a stand-alone Index Color image.

e Explicitly map the image pixel into the colortable, resulting in a True
Color image, with no map segment.

In the following steps, each one of these three ways is used.

Displaying an image with an external map segment

18. Duplicate the Display Image glyph and place it below the second Add
glyph. Connect its first input to the output of this Add glyph and connect
the second input, which is the Input Color Map parameter, to the output
of the ASCII to Map glyph.
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19.

20.

21.

Execute the glyph and verify in the displayed image that the image is
now colored with the imported map segment as the table for the indexed
image. Note that the pixel values displayed by the Display Image glyph
are the pixel values stored in the value segment. Connecting it directly
to the input colormap of the visualization tools is the first use of the map
segment.

Tip: You may need to rerun the Display Image glyph if the workspace
is in the ready mode.

Creating an image with value and map segment

Find the Insert Segments glyph (Data Manip, Segment Operators) and
place it below and to the right of the ASCII to Map glyph. Connect its
first input to the output of the second Add glyph and the second input to
the ASCII to Map glyph. This copies the value segment of the grey-level
image with the map segment, generating a new data file which contains a
value segment and a map segment.

Data Header of an image with value and map segment

Use a duplicated copy of the Data Object Info glyph to confirm the
header information of the output data of the Insert Segments glyph.
The file is stored in the KDF format, its value segment is of size (128 x
128), and its map segment is of size width = 3 and height = 8.
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22.

23.

24.

Storage Format: kdf

-- Value Data --

Data Type: Unsigned Byte (4)

Size: Width=128, Height=128, Depth=1, Time=1, Elements=1
-- Map Data --

Data Type: Double (1024)

Size: Width = 3, Height = 8, Elements = 1,

Depth Dimension = 1, Time Dimension = 1

H O HF O HHHH

Displaying an image with the map segment

Duplicate the Display Image glyph and place it to the right of the Insert
Segments glyph. Connect the first input to it.

Execute the Display Image glyph and move the mouse over the displayed
image. You will notice that the pixel values come from the value segment
as before. That is because the map segment is being used to dictate the
displayed color. An image with the value and the map segment together
is the second use of the map segment. The image created is an Indexed
Color image.

Creating a True Color image from an image with the
map segment

It is possible to apply the table stored in the map segment of an image
to create another image in which the pixel indexes are explicitly mapped
through the map table. This converts an Indexed Color image into a True
Color image.

Find the Map Data glyph (Data Manip, Map Operators) and connect its
input to the Insert Segments glyph.
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25.

26.

27.

28.

Duplicate the Data Object Info glyph and connect it to the Map Data
glyph.

Execute the Data Object Info glyph to print the header information of
the True Color image to understand the difference of this new data file.
The image has only a value segment with a new size of 128 x 128 by 3
elements. Note that storing this image requires nearly three times the
space of the image with value and map segments.

Storage Format: kdf

Color Space Model: O (invalid)

-- Value Data --

Data Type: Double (1024)

Size: Width=128, Height=128, Depth=1, Time=1, Elements=3

H OB H HH

Displaying the True Color image

In the header information of the map image above, the color model is
invalid. To display this image as an RGB image, you set the attribute
color to the RGB model, following the same procedure used in section 4.1.

Find the Set Attribute glyph (Data Manip, Object Attributes). Place it
to the right of the Map Data glyph and connect its input to the Map Data
glyph. In its pane, enable the Colorspace option and select RGB.

Duplicate the Display Image glyph and display the output image of the
Set Attribute glyph. It is a True Color image. Move the mouse over the
pixels of the displayed image and note that there are three pixel values
(R, G, and B) associated with its pixel coordinates.
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29. Save the workspace under the name color-circles-RGB-map.wk. A
screen dump of the complete workspace and the created images can be
seen below.

4 Putimage: ivart

File

(107% 117 = 0}

4 Putmage: vart

i
{74% 0= 0)

Ll

Tle
- Putimage: ivartt | (||
e

I
4 Putimage: svarit
. Ll
File
4 Puldata: ivarimpiio251A 47 4 4 (126%x 6= 0}
0x 0= 0 0 0

File

4.4 Mask Segment

Another segment in the Polymorphic Data Model is the mask segment. Its
function is to identify pixels in the value segment which are invalid. The size of
the mask segment is the same as the value segment because there is a one-to-one
correspondence between every pixel in the value segment and every pixel in the
mask segment. A mask pixel value of 0 indicates that the correspondent pixel
in the value segment is invalid; otherwise the pixel is valid. The mask segment
can be used whenever the image is not rectangular. Typical examples of non-
rectangular images are found in ultrasound and CT (computer tomography)
systems. Another application of the mask segment is when a non-rectangular
Region Of Interest (ROI) is selected in an image.
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Building the workspace to experiment with the mask
segment

In the workspace described below, the tool Extract ROI is used to manually
extract a Region Of Interest in an ultrasound image. This tool masks the
data outside of the delimited area. Compare the mean value computed by the
Statistics tool when applied to the whole image and to the ROI image with
a mask associated with it.

1. Clear the previous workspace and find the Images (Misc) glyph (In-
put/Output, Data Files). In its pane, select the image Ultrasound of
Infant Head.

Interactive ROI extraction tool

2. Choose the Extract ROI glyph (Visualization, Interactive ROI Extrac-
tion), place it to the right of the Images (Misc) glyph, and connect its
input to it. In its pane, select the parameter ROI Shape as Freehand to
activate the Region Of Interest that is defined interactively by freehand
drawing.

3. Find the Data Object Info glyph (Input/Output, Information) and con-
nect it to the output of the Extract ROI glyph.

Selecting a Region Of Interest

To extract a freehand Region Of Interest, run the Extract ROI glyph and,
on the displayed image, begin by clicking the left mouse button on a start
point of the shape to be drawn. While holding the button down, move
the mouse around the desired shape. A line is drawn as the mouse moves.
When the mouse button is released, a line connecting the start point
automatically closes the contour and the extracted region is displayed in
the extracted window and an output file created.
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4. Run the Extract ROI glyph to extract the ultrasound cone-shaped image
with the freehand drawing tool. If you are not satisfied with the contour
you can redraw it and the Region Of Interest will be updated in the
extracted window.

5. Exit the Extract ROI tool by clicking on the button.

Note: Do not exit by clicking on the glyph button again, as this
makes the extract file invalid.

Verifying the header of the extracted image

6. Run the Data Object Info glyph to see how the extracted data is stored.
An excerpt of the data header output is shown below.

Storage Format: kdf

Color Space Model: AccuSoftGB

-- Value Data --

Data Type: Unsigned Byte (4)

Size: Width=564, Height=404, Depth=1, Time=1, Elements=1
-- Mask Data --

Data Type: Unsigned Byte (4)

Size: Width=564, Height=404, Depth=1, Time=1, Elements=1
Masked Value Presentation: Use Actual Values

-- Map Data --

Data Type: Unsigned Byte (4)

Size: Width = 3, Height = 256, Elements = 1,

Depth Dimension = 1, Time Dimension = 1

H OH HF H H K HHHHEHHHE

Note that the data file has three data segments: value, mask, and map.
The mask segment has the same size as the map segment, which is 564 x 404
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pixels'. The reason this output data file also has a map segment is be-
cause the ROI extractor tool copies the image that is actually displayed
and every displayed image has a color map. In this case the color map
is a grey-level color map. The size of the map is width = 3 and height
= 256, to represent the 256 grey-tones of an image with pixel data type
Unsigned Byte.

However, grey-level images do not need a map segment; the shade of
grey is implied by the pixel value. Therefore, remove the map segment
by creating a Remove Segments glyph (Data Manip, Segment Operators)
and opening its pane to specify that it is the map segment that is to be
removed.

Displaying a masked image

7. Find the Display Image glyph (Visualization, Non-Interactive Image Dis-
play) and connect its first input to the output of the Extract ROI glyph.
Execute it and verify that there are pixels whose values are displayed
and pixels whose values are not displayed, by moving the mouse over the
displayed image. The pixels that are not shown are the masked pixels.

+ Pulimage: ireusarchiv oroas & sampiedata dais mages ulrscurd o [
P

(326x M9 B9

Making measurements on masked images

Compare the mean grey-value of the original ultrasound image and of the
ROI extracted image.

8. Use two copies of the Statistics glyph (Data Manip, Analysis & Infor-
mation), one connected to the original image (Images (Misc)) and the
other connected to the Extract ROI glyph.

I This size may be different depending on how large you extract the ROIT
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The mean value of the original image is 80.9253, while the mean value of
the masked image is around 130. The reason the mean value is higher
in the masked image is that the black portion of the image around the
cone-shaped ultrasound image is not considered in the mean computation
of the masked image.

9. Save the workspace under the name mask-ultrasound.wk.

Conclusion

In this chapter you have experimented with the map and the mask segments of
the Polymorphic Data Model. You created a colored image in the RGB model
to understand the advantages of representing a colored image using the map
segment. You worked with the interactive Extract ROI glyph and learned how
a mask segment is used to define a non-rectangular Region Of Interest in images.

The next chapter introduces you to advanced aspects of VisiQuest pro-
gramming such as procedures and flow-control glyphs.



Chapter 5

Advanced VisiQuest
Programming

5.1 Procedures

Similar in concept to a subroutine in a textual programming language, a visual
programming procedure allows you to modularize a visual program in a hierar-
chical manner. Procedures promote the readability of a visual program. The
use of procedures is more effective with large and complex workspaces.

Creating a procedure

In this section you will learn the fundamentals of procedures. The experiment
will be based on the threshold-mean.wk workspace. The purpose of this pro-
cedure is to threshold an image by a value given by the image mean added by
a parameter K multiplied by the image variance:

threshold = mean + K * variance

where K is the procedure input parameter.

1. Clear the previous workspace and restore the threshold-mean.wk
workspace created in section 3.8. In the pane of the Print Stats glyph,
enable the standard deviation variable to be std_dev. With this change,
the workspace has two variables: mean and std_dev.

The threshold value will depend on the two variables above and on the
input parameter K of the procedure. First you will use a fixed value for K of
0.1. Later you will modify the workspace to incorporate the parameter X.

2. In the “>"pane, change the constant value to mean - 0.1 * std_dev.

3. Reset and run the workspace to verify if it is working properly. You
can verify that the workspace is working if the parameter used for the
“>”olyph is 80.6146.
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Tip: You can verify the value used in the “>”glyph, by looking at its
equivalent command line that appears in the VisiQuest output console
as the glyph is executed. The command line equivalence of the “>”glyph
is kcompare -gt. The output should be something like

$DATAMANIPBIN/kcompare -gt ... -real 80.6146 .

4. Put the workspace in stop mode by clicking on the VisiQuest icon.

Selecting glyphs for the procedure

5. Create the procedure by selecting the Print Stats and the “>”glyphs.
To select more than one glyph simultaneously, either press the <Shift>
key of the keyboard while clicking on the glyph, or create a rubber-band
rectangle around the glyphs by holding the left mouse button down while
dragging the mouse to cover the area containing the glyphs.

Procedure creation

6. Select Create Procedure from the Control pulldown menu. The selected
glyphs are now replaced by the procedure. Change the name of the pro-
cedure glyph to Dynamic Threshold by clicking on the procedure name.

IThis value is obtained when processing the gull image
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7.

10.

Run the procedure glyph by clicking on the middle square button as you
run the normal glyphs.

View the contents of the procedure glyph by clicking on the white triangle
at the top-right corner of the procedure glyph. The glyphs of the proce-
dure appear in an inner level of the workspace. The external input and
output connections are represented by small boxes. Tip: You may want
to move the external input and output connections to the right and left,
respectively, if they are bunched up together or obscured by the glyphs
when the procedure is created.

j Dynamic Threshald !

. Close the procedure by clicking on the top-left icon in the procedure

workspace.

Notice that the procedure glyph has a pane like any other glyph.

Open its pane to see that the input and output file parameters are present
in the procedure pane.
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Dynamic Threshold

o —
fvarftmpfio2sl AG63
image :mtf

11. While the input and output file parameters are present, they may not
have been placed on the procedure pane the way you would like. Put the
procedure pane in edit mode by holding down the shift key while you click
the left mouse button in the procedure pane. Use the mouse to drag the
output file parameter to the bottom, and arrange the procedure pane so
that the input file and the output file are in order.

4 Procedure |_|_|_|

Procedure

12. Now, display the menuform of the input file parameter by clicking on it.

4 Inputfile Selection Me nuform |l

Inputfile Selection HELP CLOSE

Activate True ’ Optional F2
Live False F Opt el | Selected F

[ width Tacked# v Width f

| Default I F
Title Ilnput 4
Variableli 5
Desc IFlrst Input data object F

Check input file for existencesread permission? Ma |’ Delete

13. Change the variable of the input file from i1 to i and the title of the input
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14.

15.

16.

file parameter from Inputl to Input.

Inserting parameters in the procedure pane

So far, the procedure implemented the equation mean - 0.1 * std_dev
for the thresholding. To change the equation so that the constant 0.1 is
replaced by a procedure input parameter, use the Ezport GUI mechanism.
With this mechanism, it is possible to export any parameter of any glyph
in the procedure to the procedure pane.

Before using this mechanism, rearrange the procedure so that the param-
eter 0.1 can be given as a parameter in a glyph. The easiest process is
to create a single pixel image whose pixel value is given by the parameter
that will be exported to the procedure pane. When this is done, you read
this pixel value and assign it to a variable, such as K, that will be used in
the new expression for the “>”glyph.

Open the procedure by clicking on the top-right corner of the procedure
glyph.

Find the Constant glyph (Input/Output, Generate Data) and place it
below the Print Stats glyph. In its pane, set the Real Constant Level
to =0.1. When this glyph is executed it generates a single pixel image
with the value -0.1. This is the parameter that will be exported to the
procedure pane.

Find the Print Value glyph (Data Manip, Analysis & Information) and
place it to the right of the Constant glyph, then connect its input to the
output of the Constant glyph.
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17.

18.

19.

20.

21.

22.

In the pane of the Print Value glyph, set the parameter Variable Name
to K. When this glyph is executed it reads the first pixel of the input
image and assigns its value to the variable K.

e —

Now, change the expression in the “>”glyph pane to include the variable K.
In its parameter Constant, change the expression to mean + K * std_dev.

To finish the procedure, the control connections should be rearranged so
that the variables K, mean, and std_dev have their values properly assigned
before the execution of the “>”glyph.

Connect the output control connection of the Print Value glyph to the
input control connection of the Print Stats glyph.

The final procedure workspace is shown below.

Exporting a parameter to the procedure pane

At this stage the procedure is properly modified so that the parameter Real
Constant Level of the Constant glyph can be exported to the procedure
pane.

Open the pane of the Constant glyph.

Put the pane in “edit mode” by selecting the GUI Editing in the Options
pulldown menu in the pane. The pane background changes to a grid,
indicating that it is in “edit mode.”

Select the Real Constant Level parameter by clicking on it. Its four corners
indicate that the parameter is selected.
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- |f" te Object Containing Constant Value Da

Generate Object Containing Constant Yalue Data

Run || Help || Close |

v width |1
v Height |1

W W W W

float H

23. In the Options pulldown menu in the pane, select Ezport to Workspace

GUI This operation exports the selected parameter to the procedure pane.
Finally, close the pane.

24. Close the procedure by clicking on the top-left corner icon of the procedure
workspace.

25. Open the procedure pane and verify that the Real Constant Level was
properly exported.

4 Procedure |_|_|_|

Frocedure

image:mtf
fvarftmpfioZ2s1 A.69

Real Constant Level |_|;|_1 |’

26. Run the workspace and verify that it is working properly.

27. Save this workspace under the name threshold-procedure.wk.
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In the software development chapter you will learn how to create a compiled
workspace based on the procedure created here. The compiled workspace is a
glyph installed in VisiQuest which has all the functionality of a procedure.

5.2 Flow Control

VisiQuest has other types of glyphs that are used for data-flow control in the
workspace. With the flow-control glyphs it is possible to create programs with
repetitive loops.

Loop example in VisiQuest

A prototype example of a repetitive loop is available in the SAMPLEDATA
toolbox under the alias workspaces:Feedback. This workspace is a model to
create loops in VisiQuest. You need a loop in the workspace whenever you
generate data iteratively. In the Feedback workspace an image is generated by
iteratively concatenating vertical bars of increasing grey-values.

1. Clear the previous workspace and load the workspaces:Feedback
workspace.

The output generated by this workspace is an image with 21 vertical con-
stant rectangles of increasing values varying from 0 on the first rectangle
on the left side of the image to 200 on the rectangle on the right side of
the image. This image is shown below.

The general idea of the algorithm implemented in the workspace is to
iteratively prepend a rectangular constant image to the right side of the
image. The constant value used is increased at each iteration by 10 until
200 is reached.

The regular processing glyphs required in the workspace are two: the
Constant glyph, to generate a constant rectangle image, and the Append
glyph, to attach two images sideways.

Flow-control glyphs

The required flow-control glyphs are the Expression glyph, the Merge
Paths glyph, and the If Else glyph.
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The Expression glyph copies the input data to the output data and eval-
uates its associated expression given in its pane. This glyph is used in two
places in the Feedback workspace. One place is in the initialization part
of the workspace to set the iterate variable LEVEL to 0, and the other is
in the loop itself to increment LEVEL by 10.

EXPRESSION: Exprassion Contral Structure

mjoje
Expressian
LEVEL += 10
#
Expression is Evaluated when Input is AYAILABLE
-.'varnmpnnm B7.75 ‘
Input is propogated to Output
-Narm’npli051 B7.75 ‘

The Merge Paths glyph is the point where the data cycles back in the
loop. It has two inputs and one output. The output data is copied from
the most recent input. In the workspace, the first input comes from the
initialization expression and the second input comes from the feedback
data flow, where the data is accumulated iteratively.
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The If Else glyph is at the end of the loop. It has one input, two outputs,
and a conditional expression. If the conditional expression is true, the
input is copied to the first output; otherwise it is copied to the second
output. In the case of the Feedback workspace, the conditional expression
is LEVEL < 200, making the iterative process stop when LEVEL reaches
the value 200.

4 IF ELSE: li-Then-Else Control Structure

IF ELSE: If-Then-Else Caontrol Structure

opun—
- Ivarftmpfio4F4E.21

IF Conditional Expression | LEVEL < 200

THEM OQutput if Evaluation is TRUE

- Ivarftmpfio51 B7.75

ELSE Output if Evaluation is FALSE

- fvaritmpfiod1 B7 .73

The part of the workspaces:Feedback workspace related to the feedback
flow-control loop was rearranged and shown below to highlight the func-
tionality of each glyph.

The regular glyphs used in the inner part of the loop are the Constant
glyph and the Append glyph. The Constant glyph creates a rectangle with
constant value given by the variable LEVEL. The Append glyph places the
rectangle image generated by the Constant glyph on the right of the image
that comes from the loop path.

Two control connections in the loop path are required in this example. The
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Constant glyph must be executed after the variable LEVEL is iterated by
the Expression glyph and the Append glyph must be executed after the
Constant glyph is executed.

The workspaces:Feedback in the SAMPLEDATA toolbox is shown be-
low.

The other glyphs presented in this workspace are used to visualize the
data in the inner part of the loop and in its output.

2. Execute the workspace and follow the iterative process of the image cre-
ation from the visualization glyphs connected to the inner part of the
loop.

5.3 Data Transport/Distributed Processing

Data transport refers to the method used to transfer data between processes
(operator/glyphs). Earlier, data files were used as the data transport mecha-
nism. VisiQuest supports different mechanisms that can be local or remote.
Local transport mechanisms include files, shared memory, memory mapped files,
and streams. With the use of remote data transports, the capability of getting
input from and output to remote computers is implemented and distributed
processing of that data is possible. The only remote transport mechanism sup-
ported by VisiQuest is TCP/IP sockets. For detailed information, please refer
to the VisiQuest Foundation Services Manual.

Distributed Processing is the ability to specify remote computers on which
to execute individual programs. The capability of performing distributed pro-
cessing of data is implemented via the TCP/IP socket remote data transport
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mechanism. This capability is specifically useful with large data sets and for
problems that require the number-crunching capability of a supercomputer.
Note: These two features are currently not supported by VisiQuest in the
Windows NT operating system; however, all UNIX and Linux version do.

Your computer system dictates which of the data transport mechanisms
are available for your use in VisiQuest. You can choose the data transport
mechanism via VisiQuest or the CLUI of each operator. If no data transport
mechanism is specified by the user, the VisiQuest transport distribution routines
negotiate the transport mechanisms automatically. The syntax used to select a
specific transport mechanism is

identifier = token

The identifier is one of the data transport mechanisms listed earlier. The
token is an identifier for that transport. For a file, it is simply the filename. For
shared memory, it is the shared memory key. For a pipe, it is the input and
output file descriptors, as in pipe = [3,4]. For a socket, it is the number of
the socket, as in socket = 5430.

Data transport mechanisms

This section shows how to change the data transport mechanism of a connection
in a workspace.

1. Clear the previous workspace and load the export-data-gaussian.wk
workspace.

Select different transport mechanisms between the glyphs.

2. Click on the connection that links the 2D Gaussian and the Display 2D
Plot glyphs, to bring up a connections menu pane. Select the Memory
Map (mmap) option and click on the button. These two glyphs will
now exchange data via memory map.

Note: You can see what data transport mechanism is being used between
two glyphs by turning ToolTips on (select Activate Tooltips from the Help
menu) and resting the cursor on a connection.

3. Repeat this procedure for the connection between the Supported Formats
and File Viewer glyphs, but this time select the transport mechanism
Shared Memory(shm). The two glyphs will now exchange data via shared
memory.

4. Run the workspace and observe the console portion of VisiQuest to verify
the transport mechanisms being utilized.

Note: The default data transport mechanism for connections in VisiQuest
is files. You can change this setting in your Preferences file. Select Prefer-
ences from the Options menu to display the Preferences subform. Click on the

button to display the workspace attributes pane. At the bottom
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of the pane, you can set the default transport type for new connections. Click-

ing on ‘ Apply Changes ‘ installs the new setting for this session of VisiQuest.

If you then click on | Save Preferences |, the current preference settings will be
re-installed for the next VisiQuest session.

4 |Cantata —--Workspace File researchivision'oasis/Tests/handsonworkspaces/expori-data—gaussian.
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# {new? IMAGE igauss_func 2D Gaussian
$IMAGERIN igauss_func —wsize 512 -hzize 512 -type 10 -o "mmap=Fvarstmp/io3B05,1" -wpeak 256 -hpeak 256

# {new? DATAMANIP kformats Supported Formats
SDATAMANIPBINAKformats -1 “mmap=/war/tmpsi03B05,1" -0 "shm=/var/tmp/103B05,3" -ascii

# {new? ENVISION putplotZ Display 20 Plot
SENVISIONBINAputplot? -i “mmap=swarstmp/io3B05,1" -axis?d 1 -ptype2d 1 -ltype2d 1 -mtype2d 12 -pcolorZ

# {new? DESICGN khelp File Yiewer
$DESIGMEINAhelp =i "shm=/war/tmp/io3B00,3"

Conclusion

In this chapter you created a procedure and learned how to create loops inside
VisiQuest. The loop example given is a prototype model to be used whenever
you program an iterative process inside VisiQuest. You have also seen that the
files linking the glyphs are not the only data transport mechanisms available. It
is an important feature that makes VisiQuest suitable for distributed computing,.

In the next chapter, you will develop software in the VisiQuest environment.
You will create a toolbox and install an object based on the procedure created
in this chapter. You will build a kroutine object written in the C programming
language using the software development phases of interface design, coding,
installation, and testing.
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Chapter 6

Introduction to Software
Development in VisiQuest

This chapter introduces the software development tools available in the VisiQuest
system. These tools facilitate the development of programs and applications.
The software development environment supports the iterative process of devel-
oping, documenting, maintaining, delivering, and sharing software. The two
principal tools are craftsman and composer.

craftsman is responsible for managing a toolbox. It can create, delete, and
copy toolbox objects as well as software objects. composer is the user interface
to the software objects and can invoke all the operations needed to edit and
manage them. For a detailed description of toolbox programming, please refer
to the VisiQuest Toolbox Programming Manual.

Setting up your preferred text editor

Before going through the software development experiments, it is important
to select a text editor of your choice. The editor will be invoked whenever
craftsman, composer, or guise require a file to be edited. The kconfigure
routine, used to configure the VisiQuest system, does not configure the edi-
tor. The editor must be set up later in the .VisiQuest_env file generated
by kconfigure. You can include a line in the .VisiQuest_env file defining
the VisiQuest _ EDITOR environment variable or you can execute the following
command at the UNIX prompt to choose the editor as xedit:

Y%setenv VisiQuest EDITOR “xedit %f~

If you want another editor or want more information on setting up the text
editor, refer to the VisiQuest Installation Guide, section 2.5, “Setting Up Your
Environment.”
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6.1 Creating a Toolbox

Each program of VisiQuest is located in a toolbox. A toolbox is a collection of
programs and libraries that are managed as an entity, also known as toolbox
objects. It is necessary to have written access to a toolbox to develop software in
VisiQuest. In this section, you will create a toolbox under the name HANDSON.

Creating a toolbox

1. Exit VisiQuest, if it is running, and execute craftsman:

Y%craftsman

4 |Craftsman: Software Development Environme nt

File Edit Options Toolhox Object Help

Toolboxes (63) (no toolhox selected)

-
acs
acs_test

audio

hootstrap
datamanip
datasery
db_migrate
design
dev_utils
devel
documentation [=]

2. Select the Toolbox pulldown menu and choose Create Toolbox.... Give your
toolbox a name and a path. Specify handson as the Toolbox Name and
~/handson as the Toolbox Path. The “ ~ ” symbol indicates the top level
of the user home directory structure.

Note: You need to have written permission to the Toolbox Path directory;
otherwise an error will be reported.



6.2 Creating a Compiled Workspace 113

4 |Craﬂsman: Creating a new toobox

Create a Mew Toolbox

Required Attributes

Toolhox MName IHHNDSON

Toaolhox Path I...mandsgn

Optional Attributes

Toolbox Title I Hands- On Toolbox

Toalbox Author

Mame I firstname lastname

Email I usemame@site.com

Create Toolhox

3. Click on the | Create T001b0X| button. A notify window pops up and
remains until the toolbox has been created. When craftsman has finished
creating your toolbox, close the Create Toolbox subform and the toolbox
just created appears in the scrolled list of Toolbozes, preselected for you.

4. Finally, exit craftsman.

6.2 Creating a Compiled Workspace

In section 5.1 you created a visual language procedure. Here, you will learn how
to create an compiled workspace. A compiled workspace has a number of ad-
vantages over procedures. First, it allows you to install the compiled workspace
glyph in VisiQuest and access it as you would any other glyph. Second, it can
be executed through the command line as with any other operator. Third, it
eliminates a great deal of overhead by eliminating the visual aspect of program
executing, making the program run faster. Finally, you can deliver a compiled
workspace solution to a customer independently of VisiQuest, provided that you
also include the binaries associated with the glyphs in the workspace as part of
the delivery.

In this section, you will create a compiled workspace based on the thresh-
olding procedure saved in section 5.1.

Creation of a compiled workspace is very similar to the creation of a pro-
cedure, as explained in section 5.1. Follow these steps to build the compiled
workspace.
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1. If VisiQuest is still running, exit it and restart it again so that the new
HANDSON toolbox will be visible in VisiQuest.

2. Load the workspace created in section 3.8 under the name threshold-mean . wk.

ivariimp/io251A 2c

(143% 67 = 255)

Creating the compiled workspace

Like the procedure in section 5.1, the compiled workspace will consist of
the Print Stats glyph and the “>"glyph.

3. You will not need the Data Object Info, the first Display Image glyph,
or the Statistics glyph. Delete them.

4. Select the Print Stats glyph and the “>"glyph.
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o N O Ot

. Select handson from the Toolbox List.

. Fill in the parameters

Sub-category:

Parameter Value

Object Name: kdynthresh

Icon Name: Dynamic Thresh.
Category: Handson

Thresholding

. Select Compile Workspace from the Workspace menu.

. Verify that Compiler Type is set to Default Workspace Compiler.

. Verify that Install In VisiQuest is set to True.

These parameters indicate that the compiled workspace will be installed
in your toolbox and will appear in VisiQuest as the Dynamic Thresh.
glyph in the (Handson, Thresholding) menus.

Toolbox List

Campiler Type | pefault Workspace Cnmpilerl

Help | Clase

Object List

Titw

Tormats

geametry

image
imagine

ipsart_em

insart foundation

Ohbject Name I kdynthresh

lcon MName I Dynamic Thresh.

Create a Default Compiled Workspace

Category Handson

¥ The

|#
|

Install in Camata7‘ Vi |

|Create Default Campiled Workspacel
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10. Click on the | Create Default Compiled Workspace | button.

This action builds the software object kdynthresh in the HANDSON tool-
box. You will see the output in the VisiQuest console window, as the
compiled workspace files are created and updated, Pmakefiles are gener-
ated, and the compiled workspace executable is compiled and installed in
the HANDSON toolbox.

Executing workstation compiler as follows:

>$IMAGINEBIN/kdefcmpl -cat "Handson" -wksp "/var/tmp/wkspl069.3" -pane ...

Creating $HANDSON/objects/kroutine/kdynthresh/uis/kdynthresh.pane
Creating $HANDSON/objects/kroutine/kdynthresh/wksp/kdynthresh.wksp
Creating $HANDSON/objects/kroutine/kdynthresh/html/kdynthresh.htm
Creating $HANDSON/objects/kroutine/kdynthresh/src/Pmakefile
Creating $HANDSON/objects/kroutine/kdynthresh/Pmakefile
Generating $HANDSON/objects/kroutine/kdynthresh/src/main.c

11. Place the compiled workspace glyph in the workspace.
12. Close the Compile Workspace subform.

13. Run the workspace and verify that it is working properly. It should pro-
duce results identical to the threshold-mean.wk workspace.

Editing the compiled workspace glyph’s GUI

14. Open its pane to see the input and output file parameters that were au-
tomatically exported to the glyph’s pane.

4+ [Default Compiled Yorkspac

Default Compiled Workspace

Ivarftimpfio1069.7
image:mtf
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15. Notice that the input and output parameters need rearranging. Put the
pane in edit mode by selecting GUI Editing Off from the menu.
Use the mouse to drag the output file parameter to the bottom and the
input file parameter to the top.

16. Change the variable name of the input parameter. Display the menuform
of the input file parameter by clicking the middle mouse button on it.

17. Change the Title from Input 1 to Input and the Variable from i1 to i.

4 Inpuifike Selection Menuform |l

Inputfile Selection HELP CLOSE

Activate True ’ Optional F2
Live False F Opt Sl | Selected F

[ width Tacked# v Width f

| Default I ’
Title Ilnput #
Variableli ¥
Desc Iﬁrst Input data object F

Check input file for existencesread permission? Mo |’ Delete

18. Now, open the compiled workspace glyph to display its contents. Click
on the white triangle at the upper right hand corner of the glyph. Tip:
Often, compiled workspaces and procedures are created with their external
input and output ports bunched up together so that they are difficult to
see. In this case, use the mouse to re-position the input and output ports
by selecting the border og the box.
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Exporting parameters to the compiled workspace pane
19. Open the pane of the “>”glyph, and put it in edit mode by selecting GUI
Editing Off from the menu.
20. Select the TRUE and FALSE Value parameters.
- TRUE Value | 255 f
- FALSE Value |D F oo
21. Select Export to Workspace GUI from the menu to export the
selected parameters to the GUI of the compiled workspace glyph.
22. Close the pane of the “>”glyph.
23. Close the compiled workspace by clicking on the top-left corner icon of
the compiled workspace.
24. Go back to the pane of the compiled workspace. Resize and position the
TRUE and FALSE Value parameters on the pane as shown below.
4 Default Compiled Workspace |
Default Compiled Workspace
Run || Help || Closa |
T
25. Take the compiled workspace pane out of edit mode by selecting GUI
Editing On from the menu.
26. Any time you make changes to the compiled workspace, either in the

GUTI or in the glyphs in the workspace, you must regenerate the compiled
workspace. Select Save Changes from the menu. This will re-
generate the compiled workspace with the modifications to its GUI. Tip:
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27.

28.

29.

You can also save changes by clicking on the Compile Workspace icon that
appears on the far right hand side of the VisiQuest command bar.

Close the compiled workspace pane.

Test the compiled Workspace

Verify that the compiled workspace operates correctly with its new pa-
rameters.

Open the compiled workspace pane and provide values of 175 and 150 for
TRUE and FALSE, respectively.

Run the workspace. Check the console window for the arguments provided
to the kdynthres routine. You should see ~tval 175 and -fval 150. The
output image should also reflect the difference.

6.3 Creating a Kroutine

In this section, you create a glyph based on a software object written in the
C programming language (a kroutine). For illustrative purposes, this glyph
will perform the simple operation of reading a data file and printing to stdout
(Green Console Button) the pixel value of a specified coordinate. The name of
this object will be kpixel.

You develop software using VisiQuest by creating software objects. To create
an operator software object, you need to:

e Design its GUI pane interface.

e Use the code generator to create the user interface code.

e Add the code that implements the operator.

e Compile and install the operator.

e Test the operator using VisiQuest or the CLUI interface.

Creating a kroutine object

1.

2.

Exit VisiQuest, if it is running, and invoke craftsman in the background:

Y%craftsman &

Select the handson toolbox from the list of Toolbozes.
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3. Select Create Object in the Object pulldown menu.

4. In the Create a New Object subform, fill in the information for the software
object kpixel as follows. Note that the information below is regarding
the creation of a kroutine type of object. A kroutine is an object written
in a compiled programming language such as C or C++. The kroutine is
the default class type for creating a new software object; software objects
of other class types can be created by selecting the desired class type from
the Select Classtype pulldown menu.

Parameter Value
Toolbox Name handson
Object Name kpixel
Binary Name kpixel

Icon Name Pixel
Author your name
Email Address your email
Short Description Reads a pixel value
Generated Language C

Install in VisiQuest? Yes

Category Handson
Sub-category Information
Continuous Run Driver No

Strict Arguments True
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Create new ohject in HANDSOMN
Select Classtype

Create a new Krautine object

Toolbo:x Name IHANDSON

Ohbject Mame Ikpixm

v Einary Mame I

[V lcon Name I

v Author IJohn Doe

|V Email &ddress Iiohn@anywhere.com

Shart Description of Ohbject:

v IReads a pixel value

Generated Language? IV c | Ces

Install In Cantata? [ Trya |

v | category Hands On

[V | subcategory Information

Continuous Run Driver? Strict Arguments?
I_ Generate debug code? I_ Force? Create KROUTINE

5. When the parameters are all typed in, click on the| Create AccuSoftOUTINE |

button. A notifier informs you of the object creation process.

6. When craftsman has finished creating your object, close the subform.

Editing the kroutine object

Once the object is created, you can edit to your specifications. The VisiQuest
tool used to edit an object is composer. Using composer, you edit:

e The User Interface Specification UIS, the file which dictates the parame-
ters in the GUI (pane) and CLUT interfaces.

e The programming code itself.

VisiQuest simplifies these two tasks. The UIS can be edited graphically
directly on the pane interface by using the tool guise. Once the pane is edited,
composer can automatically generate code to deal with the user interface. This
means that you do not have to write any code related to user interface.

Both composer and guiseare invoked automatically and transparently from
craftsman.

1. With the kpixel object selected in the craftsman subform, select FEdit
Object (Composer) in the Object pulldown menu. This executes composer.
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4 |Gnmpnser: software object edito

File Attributes Options Help

[

| kpi=el
Zﬁlg Fmakefile
b
L help
1 html
3 man
3 src
L uis

[4]

Editing HANDSOM:kpixel (Kroutine)

Editing the pane interface

Specify the GUI/CLUI interface by graphically editing the pane of the
object by using the guise tool.

. Click on the to reveal the kpixel.pane UIS file.

Double-click on the kpixel.pane file to execute guise.

In a few moments guise will create two windows. The first is the guise
subform where you select the appropriate commands in the object pane.
The second is the pane of the object in the edit mode. Note the gridded
background in the pane object. Also note that the pane object, by default,

has already one Imput and one Output file parameter, and , ,
and buttons.
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4 Guise

User Interface

ion Editor

Fle Edit

Simple

Button

Toggle

Lst IO Organize Help

v pans [ %

< Reads a pixel value

Reads a pixel value

Help | | Close

Options

Input

Dutput

Deleting the output file parameter

As the kpixel operator requires a single file input parameter, delete the

output file parameter.

4. Select the Ouiput parameter in the pane object by clicking on it with the
left mouse button. Its four corners are highlighted indicating the selection

made.

5. In the guise subform, select Delete in the Edit pulldown menu. This will
delete the Qutput parameter from the object pane.

4 |Reads a pixel value

Reads a pixel value

Help |-

Options

Run |-

Creating five integer parameters

The object must have five integer parameters that correspond to the width,
height, depth, time, and element coordinates.

6. Select Integer in the Simple Variables pulldown menu in the guise sub-
form. This brings up an integer parameter to the pane object.
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Now change this input parameter to reflect the desired title, variable, and
description.

7. Click with the middle mouse button on the Integer parameter in the object
pane. This shows the Integer Selection subform for editing the parameter.

8. Set the following parameters in the Integer Selection subform. Verify the
changes in the object pane as you enter the new values.

Parameter value

Bounds Value >= 0

Title Width

Variable W

Desc width pixel coordinate

It is important to understand the meaning of the Variable parameter, set
here as w. This variable is associated with the parameter in the CLUI
interface. For instance, to specify width = 100, use the syntax -w 100 in
the command line. This variable is also used in the C programming code,
when you access this integer parameter for width.

Title |wmth #
\Jariahlelw F
Desc Iwidth pixel coordinate F

9. Close the Integer Selection subform.

Create the height parameter by duplicating the width integer parameter.
10. With the Width selected, select Copy in the guise Edit pulldown menu.

11. Move the duplicated parameter below the first integer parameter by hold-
ing down the left mouse button on the parameter and moving it to the
desired location.
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4 |Reads a pixel value

Reads a pixel value

| Help |-

| Input

< Width | o

S Width | g

12. Click on the duplicated parameter with the middle mouse button and
change the parameters.

Parameter Value

Title Height

Variable h

Desc height pixel coordinate

13. Create the last three parameters, Depth, Time, and FElement, by dupli-

cating and then editing each one. Use the following titles, variables, and
description for each parameter.

Title  Variable Desc

Depth d depth pixel coordinate
Time t time pixel coordinate
Element e element pixel coordinate

At the end of editing, the pane object appears as follows:
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< Reads a pixel value |_|_|_|
Reads a pixel value
: Run || Help || Close |
width[g
:Heightln
: Depth ||]
: Time ||]
i Elements ||]
LE: L
Saving the UIS file
Once the pane has been edited, it must be saved. Note that the edited
pane UIS specification is stored in the file kpixel.pane. Its path can be
found by selecting Open from the UIS pulldown menu in guise .
14. Save the UIS file by selecting from the the guise menu. You
can confirm the overwriting operation on the previous UIS file.
15. Exit guise by selecting from the menu.
Source code generation
The source code required to read the parameters of the object is generated
automatically. Every time you edit the UIS file with guise you must
update the source code files. This is a crucial step that should never be
forgotten.
16. On the Composer subform, select from the Options menu.
17. On the Commands subform, select | Generate Code | from the Make menu.

Note that several files are generated, corresponding to the C files, header
files, and documentation files of the object.
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18.

19.

Bl |C|:mr.nser CGommands: kpixel[HANDSON]

Commands: Command Options

Make |_ Make All Archs? ’ |7 Clear console on command?

SIEVELBIN/kregenobi —tb handson —onane kpixel

Running conmand *SDEVELEIN/kgenkroutine -tb handson —oname kpixel ~
Generating sr/nain,c

Generating src/nain.h

Updating htnl/kpixel htw

Generating man/kpixel 1

Generating help/kpixel hlp

Generating Prakefile in src

depend” ——
rectory Prakefile
—— Erd of Command —

Search: ‘f‘ Clear ” Save

Close the Commands subform.

Editing the source C files

Once the source code has been automatically generated, include the code
that will actually perform the operation. This object will read the input
file and will pick the pixel value at the specified pane coordinate parame-
ters.

Click on the directory in the Composer list. Three source code files
appear in the list.
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20.

21.

] |Curnpnser: software object edito

File Attributes Options Help

2 kpixel =
@3 Pmakefile

(3 dh

CJ help

3 html

L3 man

= src
ﬁ .depend
E Pmakefile
kpisel.c
B kpielh
main.c
EI main.h EI

Editing HANDSOM:kpixel (Kroutine)

To start the editor, either double click on the kpixel. cfile, or click once on
the kpixel.c file to select it and then choose Edit from the File pulldown
menu.

This displays the kpixel.c source file in your preferred text editor.

The next step is to add your code to the run kpixel() routine.

Variables declaration

Declare the variables src_obj, to hold the input data structure as a
VisiQuest software object and data to hold the pixel value, in the variable
list declaration section:

kobject src_obj;
double *data = NULL;

Opening the input file as a data object

Here, the data file is open and stored in the src_obj. The filename spec-
ified by the user in CLUI or GUI interface is available in the variable
clui_info->i file. VisiQuest automatically generated user interface
code to parse the input filename string and stored it in this variable.
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22. src_obj = kpds_open_input_object(clui_info->i_file);
if (src_obj == KOBJECT_INVALID)
{

kerror (NULL, "kpixel",
"Unable to open input object %s",
clui_info->i_file);
kexit (KEXIT_FAILURE);
}

Implementing the Algorithm

Now, add the code to read the pixel value at the location specified by the
user and assign it to the variable data. Note the way the input parameters
are related to the variables specified in the UIS pane. The variable w, asso-
ciated with the integer parameter Width, is stored in clui_info->w_int
and the same rule is applied for the other parameters. After the pixel
value is assigned to the variable data, it is printed to stdout.

23. Enter the code

if ('kpds_set_attributes(src_obj,
KPDS_VALUE_DATA_TYPE, KDOUBLE,
KPDS_VALUE_OFFSET,
clui_info->w_int, /* w input parameter */
clui_info->h_int, /* h input parameter */
clui_info->d_int, /* d input parameter */
clui_info->t_int, /* t input parameter */
clui_info->e_int, /* e input parameter */

NULL))
{
kerror ("main","kpixel",
"unable to set source object value attr.");
return(FALSE) ;
}

data = (double *)kpds_get_data(src_obj,
KPDS_VALUE_PQINT,
data);
kprintf ("Pixell%d,%d,%d,%d,kd]=kg\n",
clui_info->w_int,
clui_info->h_int,
clui_info->d_int,
clui_info->t_int,
clui_info->e_int,
datal[0]);
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24.

25.

26.

Finish & Cleanup

As the last steps, the data and the object variables are deallocated from
memory. The routine must return TRUE for success.

Enter the code

kfree_and_NULL(data) ;
kpds_close_object(src_obj);

Compiling your code

Once the code is edited, save the file and exit the editor.

The next step concerns the compilation and the installation of the object.
composer has integrated tools to compile your programs using the con-
figuration set up in the VisiQuest installation. You need to have access
to the ANSI C compiler described in the VisiQuest Installation Guide in
section 1.5.1.

Select the button from the Options menu in composer .

In Commands, choose Kmake Install from the Make pulldown menu.

It is likely that there are syntax errors introduced in the process of copying
the code into the C file. If that is the case, invoke the editor again by
choosing Fdit in the File menu of composer . Correct the errors and
repeat the Kmake Install process.

If everything works, your object has been compiled and installed success-
fully. There may be several warning messages, but you can verify that
the object has been installed if the line before the last in the Commands
subform is the install command or a message saying that kpixel is
installed.
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4 |Cumposer Commands: kpixel[HANDSON]

Commands: Command Options:
|_ hdake All Archs? f |7 Clear console on command?

$BOOTSTRAPEIN kmake install

--- "inztall” -—

kmake: Entering directory “Aresearch/viziondoazis/Tests/handsondmach/sol2 Bfobjects/
-—- "kpixel” -—

rm —f kpixel

cc -0 kpixel kpixel,o main,o -Lfresearchdvizion/oazis/dataserv/machs/zol2,B/lib -L/r
--- "inztall” -—

inztall -c kpixel Aresearch/visiondoazis/Testa/handzon/bin/=ol2,6/kpixel

rm —f kpixel

kmake: Leaving directory “/research/viziondoazis/Tests/handson/mach/=0l2,6/objecterk
————————————— End of Command —-—---—--—----—-—

(L s —

Search:l |f| Clear || Save |

27. Close the Commands window, quit composer and craftsman.

Testing the object in VisiQuest

28. If you have VisiQuest running, exit the program and invoke it again, be-
cause VisiQuest can only see the new changes in the HANDSON toolbox
when it starts up.

29. Find the glyphs:

e Images (Misc) glyph (Input/Output, Data File)

e Pixels glyph (Handson, Information). Note that this is the new
glyph you have just created using composer.

e Display Image glyph ( Visualization, Non-Interactive Image Display)

30. Connect them together as indicated below.
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31. Select the Spanish Sea Gull image in the Images (Misc) glyph.

32. Run the Pixel glyph and verify its output. The first pixel of the gull
image has value 41.

4 [Giyph Help Output

Cutput For 'Pixel”

Pixell0,0,0,0,0]=41

Mo File Currently Being Displayed

33. Test the Pixel glyph in other pixel coordinates and compare the output
values with the Display Image glyph.

34. Quit VisiQuest.

Conclusion

In this chapter, you have learned how to create a toolbox, create and install a
compiled workspace in VisiQuest, and build a complete kroutine object. You
have designed the pane interface of the kroutine and coded an operator that
prints the pixel value at specified coordinates of an image data file.



